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Context-Sensitive Help Preferences
This procedure explains how to change your help preferences in TIBCO Business Studio™
for BusinessWorks™ to access context-sensitive help from a local directory or from an
internal web server where you have placed the documents.

Before you begin
To set context-sensitive help preferences, you must first download the product
documentation from the FTP site provided by your TIBCO representative. Copy the
documentation .zip file to a local directory, or to an internal web server and then extract
the file.

Procedure
1. In TIBCO Business Studio for BusinessWorks, click Window > Preferences. On

macOS, click TIBCO Business Studio > Preferences.

2. In the Preferences dialog box, click BusinessWorks > Help.

3. Select Custom Location and then click Browse to select the html directory where
you extracted the documentation, or provide the URL to the html directory on your
internal web server.

4. Click Apply and then click OK.
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New Features
The following new features are available in this release of TIBCO ActiveMatrix
BusinessWorks™.

Release 6.9.1

Common Features

Support for XPath
normalize-unicode
function in the
XSL Transform
activity

The "normalize-unicode()" function is now added and listed under the
String functions section.

Support for
Confirm activity in
Unit Testing

This release adds support for the Confirm activity for Unit Testing.

Support is added
for additional
system properties
for process,
activity and
transition events.

This release adds support for additional system properties that help
determine which process, activity, and transition events should be
published. These system properties can be utilized as filters to exclude
events that aren't necessary, ensuring that only the essential data is sent
through the OSGi EventAdmin service and handled by the statistical
event handlers.

The system properties are:

• If the value is set to true, process events are published. If the
value is set to false, no process events are published. The default
value is true.

bw.monitor.publishProcessEvents

• If the value is set to true, activity events are published. If the
value is set to false, no activity events are published. The default
value is true.
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bw.monitor.publishActivityEvents

• If the value is set to true, transition events are published. If the
value is set to false, no transition events are published. The
default value is true.

bw.monitor.publishTransitionEvents

• If the value is set to true, only events from the main process,
including Process, Activity, and Transition events, are published. If
the value is set to false, events from all process events, including
Process, Activity, and Transition events, are published. The
default value is false.

bw.monitor.publishMainProcessEvents

Support is added
for OpenTelemetry
with
ISTIO Services.

This release adds support for OpenTelemetry with ISTIO Services.

Support is added
for custom
headers for
OpenTelemetry.

This release adds support for customer headers like api_key to
authenticate with the OpenTelemetry system on New Relic.

Support for
choosing to apply
Policy on REST
Service Binding
paths

A new check box Apply Policy to Subpaths is added on the REST
Service Binding configuration tab. The user can now choose if a policy
is to be applied to the sub-paths of a service.

When this checkbox is selected for a parent resource service path
configured with Policy, the policy will be applied to the child paths at
runtime.

If in case you do not wish to apply the policy to all the sub-paths but for
selective paths, then do not select this checkbox and add the Policy for
the required service paths.
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Common Features

For more information, see "REST Service Binding" in the ActiveMatrix
BusinessWorks REST Reference.

Palettes

Support for
streaming non-
multipart in Send
HTTP Request
activity

Sending a file as streaming non-multipart is now supported in Send
HTTP Request activity.

Support for
parsing the
Swagger files with
the special
character "$" and
whitespace

Support is provided to parse the Swagger files having element names
with the special character "$" and whitespace in the query parameters,
request, and response schema objects.

Support of Smart
Engine for HTTP-
based transport

You can now generate various HTML reports for the engine data
collected for different performance use cases with applications using
HTTP-based transport. The Smart Engine also analyzes the engine data
collected and provides recommendations to improve the performance of
your application.

For more information, see the "Smart Engine" section in TIBCO
ActiveMatrix BusinessWorks™ Administration.

Support for XSLT
stylesheet
selection in
TransformXML
activity

Support is added to select the XSLT stylesheet from the shared module
in the TransformXML activity.

Support to
override SQL
statements via
JDBC_Update
activity

An Override SQL Update Statement checkbox is added on the
Advanced tab of the JDBC_Update activity to override the SQL
statement.
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Runtime

Start an independent component of
the ActiveMatrix BusinessWorks
application

An option has been added now to start an
independent component of the ActiveMatrix
BusinessWorks application despite of an Impaired or
StartFailed state.

Support for ActiveMatrix
BusinessWorks metrics such as
system data and process stats via
OpenTelemetry

ActiveMatrix BusinessWorks metrics for system data
and process stats can now be seen on any standard
metric-supported data source via OpenTelemetry.

Support is added for B3 propagation
format on Jaeger.

This release adds support for B3 propagation format in
ActiveMatrix BusinessWorks on Jaeger.

Release 6.9.0

Common Features

Dynamic timeout in SOAP
Invoke activity

You can now use dynamic timeout in SOAP Invoke activity using
the SetContext activity.

A schema must be created with specific element names i.e.
complexType element as "dynamicConfigurations" containing the
"activityTimeout" element.

The dynamic timeout overrides any static setting in the
Advanced tab of the Invoke activity.

Deploy the same EAR with
different profiles using
Maven

A new option has been added now to deploy the same EAR file
multiple times with different profiles using bw6-plugin-maven.

Support for Inline Schema
at request and response
in OAS 3.0 Swagger files

OAS 3.0 JSON file with inline schema in request and response is
now getting parsed when creating top-down REST service or
reference binding.

Support for OAS 3.0
Multiple Response feature

Support has been added to create a top-down REST service with
OAS 3.0 JSON file having multiple response content-types.
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Common Features

Support for anyOf and
oneOf keywords in
Swagger files

You can now generate XSD and create a top-down service or
reference binding using an existing OAS 3.0 JSON file with anyOf
or oneOf keywords for request and response schemas.

Administration

Addition of a new field,
Machine name under
Application Status of
REST API.

A new field, Machine name has been added now under
Application Status of REST API. It helps to get the status of a
deployed application in a domain along with the machine name.

Design Time

Promote module
properties in a batch

With this release, you can now promote module properties in a
batch rather than individually.

TIBCO ActiveMatrix
BusinessWorks™
integration with TIBCO
Cloud API Modeler

The TIBCO Cloud API Modeler (TCAM) APIs are now available on the
TIBCO Cloud APIs website that ActiveMatrix BusinessWorks can
leverage to make the API specs from TCAM discoverable in the API
explorer.

Support for multiple
TIBCO Cloud
Integration
environments via SSO

You can now choose multiple TIBCO Cloud Integration environments
and log in via SSO. An option is provided to select a cloud server in
the SSO Settings dialog.

Support for
importing/exporting
application templates
to TIBCO Cloud
Integration
Marketplace

This feature is an integration of the Application Template with the
TIBCO Cloud Integration Marketplace via TIBCO Business Studio for
BusinessWorks. It enables you to import/publish the app templates
as marketplace listings on the TIBCO Cloud Integration Marketplace.

Test Connection
feature for Smart

A new button named Test Connection is provided on the Database
Configuration window of the Smart Mapper preferences. It enables
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Design Time

Mapper you to verify the database connection for the Smart Mapper.

Learn Existing Links
feature for Smart
Mapper

The Learn Existing Links feature enables you to store all mapping
data of all projects in the current workspace. For using this feature,
you first need to configure the DB. All the mapping data gets stored
in the respective DBs.

Importing/exporting
recommendation info
via Smart Mapper.

This feature enables you to import/export the recommendation info.
The Import button helps to import the mapping data present in the
DBnfo file into the configured DB. Similarly, the Export button helps
to export the mapping data present in DB to the DBinfo file.

Palettes

Support for OAuth 2.0
Authentication in Receive Mail
Activity

OAuth 2.0 Authentication is now supported for Receive
Mail Activity IMAP protocol in the Mail palette.

Support for XML type input
parameter in Oracle stored
procedure

XML type input parameter in Oracle stored procedure is
now supported for Oracle.

Runtime

Force stop
application via
Engine
Command
activity

In TIBCO ActiveMatrix BusinessWorks™ 6.x, the stopapplication command is
used in the Engine Command activity which gracefully shutdowns the
application. Since it is the graceful shutdown of applications, it waits for all
jobs to get completed.

This enhancement is raised to have a "force shutdown/stop application" so
that it can stop the application immediately.

For the EngineCommand activity, a force option for the StopApplication
command is added to stop the ActiveMatrix BusinessWorks application
forcefully. For example, the existing process instances are canceled
immediately.
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Runtime

Introducing a
new log level,
Fatal in the
Log Activity.

A new log level named Fatal has been added to the Log Activity. This feature
enables you to distinguish the Fatal log-level messages from the Error log
messages and can also be used for observability goals.

Support for
getting the
Product
Version

In the input binding of activities and transitions, the ActiveMatrix
BusinessWorks product version can now be accessed by using the following
property:

bw:getSystemProperty("BW.VERSION")

Release 6.8.1

Common Features

Ability to share Smart
Mapper Learning via
externalized database

With this version, you have the capability to connect the
Smart Mapper to an externalized database to be able to share
learning done on one machine within your team to achieve an
improved collaborative team development experience.

Support for "allOf" keyword
in Swagger files

You can now generate XSD and create a top-down service or
reference binding using an existing JSON file with "allOf"
keyword for request and response schemas.

Support for parsing the
Swagger files with the special
characters @ and #

Support is provided to parse the Swagger files having element
names with the special characters @ and # in the request and
response schema objects.

A new field activityTimeout
under
dynamicConfigurations
element is added.

A new field activityTimeout under dynamicConfigurations
element is added to the Input tab of the REST Invoke activity
created with a reference binding. Provide the value in
seconds. At runtime, it takes precedence over the Activity
Timeout value on the Advanced tab.

Support to refer to the
external JSON from

Support is added to generate XSD and create service and
reference binding using OpenAPISpecification 3.0 JSON file,
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Common Features

OpenAPISpecification 3.0
JSON file

which refers to an external JSON file.

Creation of a web service
with one-way operations
returning faults is supported

Support is added to use One-Way operation along with Fault
replies.

Support to enforce
authentication on REST
Reference binding using the
Authentication check box on
the HTTP client shared
resource

You can now enforce basic authentication on REST Reference
binding using the Authentication check box on the HTTP
client shared resource. The Authorization header for the same
is reflected in the outbound request.

Administration

Encryption/Decryption of
profiles supported via REST
API

This release adds support to encrypt or decrypt profiles via
provided REST API to enhance encryption of profiles feature.

Runtime

Support added for
Concatenated system
Module Properties

On adding new Concatenation feature properties, properties
referencing other properties are displayed as Undefined under
Admin UI.

The iterate loop variable
resets after each iteration

Variable inside iterate loop resets now after each iteration when
you set the property to bw.engine.enable.loop.reset=true.

Design Time

Configure the REST
Endpoints in Cloud Mesh

You can configure and override the TIBCO Cloud Integration
Cloud Mesh Resource Endpoints during the deployment process.
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Design Time

via CICD.

Send the password digest
while using
UserNameToken.

Now you can send password digest while using UserNameToken
for security in the SOAP Policy.

Add Custom Xpath
function as a module
dependency.

You can now add Custom Xpath function as a module
dependency in pom.xml using TIBCO ActiveMatrix BusinessWorks
Maven plug-in.

You can run an application
using TIBCO Cloud Mesh
with Single Sign On option
selected.

When you select the Single Sign On option from Preferences and
run an application with TIBCO Cloud Mesh service, you can
select the Enable TIBCO Cloud Mesh Services Consumer check
box available under Run > Run configurations... > Advanced
Tab or Run > Debug Configurations... > Advanced Tab.

Support is provided to
connect to TIBCO Cloud
Integration from TIBCO
Business Studio for
BusinessWorks using
Single Sign-On (SSO).

This release adds support to connect to TIBCO Cloud Integration
from TIBCO BusinessStudio for BusinessWorks using Single Sign-
On for enhanced authentication.

Note: At a time you can use only one method, either SSO
Login or Password Grant, to connect to the cloud application.

Support for Assertion of
activities within a group

This release adds out of the box support for adding assertions to
the activities within a group in a process.

Support for mocking of
activities within a group

Support for mocking activities within a group is now provided.

Palettes

Nested
mimeEnvelopeElement is
visible and supported.

Now nested mimeEnvelopeElement is visible and supported in
the Input and Output schemas of the HTTP palette activities.
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Palettes

Support to provide a custom
boundary for multipart
content type

Support is provided to add the custom boundary for multipart
content type on the Send HTTP Request and Send HTTP
Response activities.

Release 6.8.0

Common Features

Support is added to
remember mappings
made in a smart
mapping session.

ActiveMatrix BusinessWorks now remembers mappings made
during a smart mapping session and provides recommendation for
mapping elements.

For more information, see "Smart Mapper" in TIBCO ActiveMatrix
BusinessWorks™ Application Development.

Out of the box support
provided for TIBCO
ActiveMatrix
BusinessWorks™ plug-in
for Apache Maven

The ActiveMatrix BusinessWorks installer now includes the installer
of TIBCO ActiveMatrix BusinessWorks™ plug-in for Apache Maven.

Support is added for
Java 11.

Now TIBCO ActiveMatrix BusinessWorks™ 6.8.0 supports Java 11 on
the Windows, Mac, and Linux platforms.

Support added for
module property for the
OAuth Configuration
shared resource.

This release adds support for module properties for the following
fields of the OAuth Configuration shared resource:

l Cliend ID

l Client Secret

l Access Token URL

l scope

l Username

l Password

l Confidentiality



TIBCO ActiveMatrix BusinessWorks™ Release Notes

15 | New Features

Common Features

Support is provided for
form parameters for
OpenAPISpecification
3.0.

REST service binding and REST reference binding now support form
parameters for OpenAPISpecification 3.0.

Support for dynamically
overriding binary
response format

You can override the binary response format only when
"application/octet-stream" is selected in the Response Media Type
using Content-Type Response Header on the Reply activity. Select
the Use HTTP Headers check box and then pass the value in the
Reply activity. The same value is reflected at runtime in the
Response headers content-type.

Support is added for
setting the request URL
dynamically on REST
reference binding

The dynamicConfigurations field is added on the Input tab of the
Invoke activity, which is used for invoking REST service with REST
reference binding. The dynamicConfigurations consists of the
following information:

URL: The endpoint URL to override from reference binding.

Note: This field is visible for newly created reference binding
only.

Support is added for
handling runtime
expressions in Callback
URL

When you drag a callback URL with runtime expressions from a
OpenAPISpecification 3.0 file to create a REST service or a reference
binding, the Resource Service Path is set to /callback and the
shared resources have localhost and 8080 as Host and Port values
respectively.

The Description field is
added on the REST
service binding.

The Description field is added on the REST service binding for all
the parameters. Set the description in TIBCO Business Studio for
BusinessWorks and the same value is reflected in Swagger UI when
you refresh the Swagger UI URL.

The SOAP Invoke
activity now sends
requests with CDATA
tags.

Request with CDATA tags can now be sent with SOAP Invoke
activity.

For the CDATA tags to remain intact on the wire, set the following
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Java property in VM arguments:

bw.binding.soap.invoke.cdata.serialization=true

Support of Binary
Response Format for
OpenAPISpecification
3.0 REST services is
provided.

The Binary check box is added in the Response Format for
OpenAPISpecification 3.0 service and reference binding.

Support added for
implementing callbacks
in OpenAPISpecification
3.0.

You can now create REST service or reference bindings from a
JSON file containing a callback URL.

REST service can return
HTML content to the
browser.

REST service can return HTML content to browser by passing
"text/html" as Content-Type header value in the response headers
of the Reply activity. Select the Use HTTP Headers check box and
Format as Text on the Response tab of REST service binding.

Enhancements are
made in Unit testing
and Mocking support.

ActiveMatrix BusinessWorks adds support for Mocking and unit
testing for the following entities:

• Main process activities

• Events or process starters

• Service Binding

• SOAP service implemented as a constructor operation

Design Time

Generate Manifest.json
file for TIBCO Cloud
projects using bwdesign.

Now you can generate Manifest.json file for TIBCO Cloud
projects by using the following bwdesign command line utility:

generate_manifest_json -project <project_name> <location
to generate manifest.json file>
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Design Time

The Use local time
option is provided in the
Timer activity.

The Use local time check box is added on the General tab of the
Timer activity. If you select the check box, the timer is triggered at
the specified Start Time value of a system from which an
application is deployed.

The temp files are no
longer showed under
Unstaged Changes.

Now the Git Staging tab does not show the temp files in the
Unstaged Changes section after committing the changes.

The temp files are added
to the .gitignore file.

Now the temp files are added to the .gitignore file.

Successful installation of
AWS CodeCommit Plugin

Now you can successfully install AWS CodeCommit Plugin by
following these steps:

1. Install Guava: Google Core Libraries for Java 21.0 from here.

2. Install Eclipse Equinox Target Components from here.

3. Install M2E from here.

4. Install AWS Code Commit from here.

The View
Documentation icon is
added for plug-ins in
Plug-in Manager

The plug-ins in the Plug-in Manager now display a View
Documentation icon. Click the icon to view the corresponding
plug-in's documentation on docs.tibco.com

Support is added for
"default" response
in REST Service.

If a Swagger file has "default" as one of the responses for REST
service's operation, then on creating a top-down REST service
from the Swagger file the same is reflected in the Response
Status tab of REST service binding.

To Reply with default fault, you must add the statusCode element
to the default fault schema. Use the following steps :

1. Open the REST service process.

2. Click on OnMessage Start > Properties > Fault tab.

http://download.eclipse.org/tools/orbit/downloads/drops/R20190226160451/repository
https://download.eclipse.org/eclipse/updates/4.11/
https://download.eclipse.org/technology/m2e/releases/1.12/
https://aws.amazon.com/eclipse
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3. Select defaultResponseSchema

4. Add statusCode as an Integer type element

If the statusCode element is already present in the default
response schema, then do not add the element.

Support is added for
Eclipse 4.19 platform for
TIBCO Business Studio
for BusinessWorks

TIBCO Business Studio for BusinessWorks is now based on Eclipse
4.19 platform.

For more information, see "Eclipse 4.19 - New and Noteworthy"
page on the Eclipse's site.

Palettes

Support is added
for TLS session
resumption

All activities from the FTP palette now support TLS session resumption
on the data connection.

Support is added to
allow or restrict IP
addresses in the
HTTP Connector
shared resource.

The following VM arguments are added in TIBCO Business Studio for
BusinessWorks to allow or restrict IP addresses.

l Dbw.plugin.http.httpConnector.allowIPs=<IP address> 

l Dbw.plugin.http.httpConnector.restrictIPs=<IP address>  

You can provide a list of IP address by using a semicolon (;) as a
separator. 
For example: 
Dbw.plugin.http.httpConnector.allowIPs=10.98.179.102;10.98.179.110.
In this example, both IP addresses 10.98.179.102 and 10.98.179.110 are
allowed.

Use a hyphen to provide a range of IP addresses. 
For example: Dbw.plugin.http.httpConnector.restrictIPs=10.98.179.102-
10.98.179.110.
In this example, IP adresses 10.98.179.102 to 10.98.179.110, both
inclusive are restricted. 

http://www.eclipse.org/
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Palettes

You can also provide a range of IP addresses along with other IP
addresses not in the IP address range separated by semicolons.
For example: Dbw.plugin.http.httpConnector.restrictIPs=10.98.179.102-
10.98.179.110;10.98.179.120.

Use a hyphen to provide a range of IP addresses.
For example: Dbw.plugin.http.httpConnector.restrictIPs=10.98.179.102-
10.98.179.110.
In this example, IP adresses 10.98.179.102 to 10.98.179.110, both
inclusive are restricted. 

The performance of
JDBC palette
activities is
improved.

Set the following VM arguments :

• -Dbw.application.jdbc.validateConnection.frequency=55

The frequency means how often to check connection validity when
inside the pool. This value must not be above the Connection Idle
Timeout property in the JDBC Connection shared resource.

• -Dbw.application.jdbc.validateConnection=false

Check whether to validate the connection prior to sending it to the
activities.

Support is added
for TLS 1.3 version.

The shared resources for SSL Server Configuration and SSL Client
Configuration now support TLSv1.3 as SSL Protocol version for HTTP,
REST, SOAP, Mail and TCP Palettes. TLS 1.3 supports only RSA
certificates.
For more information, see "SSL Server Configuration" and "SSL Client
Configuration" in TIBCO ActiveMatrix BusinessWorks™ Binding & Pallete
Reference.

Support added for
Module Properties
for additional
configuration.

l You can use a module property for configuring Confidentiality
on HTTP Connector shared resource.
For more information, see "Security" in TIBCO ActiveMatrix
BusinessWorks™ Binding & Pallete Reference

l You can use a module property for providing the HTTP
Connector Name on SOAP service binding.
For more information, see "Configuration for HTTP Transport" in
TIBCO ActiveMatrix BusinessWorks™Binding & Pallete Reference
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Runtime

Smart
Engine

You can now generate various HTML reports for the engine data collected for
different performance use cases. Smart engine also analyzes the engine data
collected and provides recommendation to improve performance of your
application.

For more information, see "Smart Engine" section in TIBCO ActiveMatrix
BusinessWorks™ Administration.

Release 6.7.0

Common Features

Smart Mapper Smart Mapper provides the ability to intelligently determine how
data is to be mapped in the activity's input tab.

This release adds support
for OpenAPISpecification
3.0.

l REST Service Binding: Now you can create and implement
a REST Service defined with OpenAPISpecification 3.0,
using both: the Swagger file as well as ActiveMatrix
BusinessWorks™ REST Service Wizard.

l REST Reference Binding: You can invoke the REST APIs
created using the OpenAPISpecification 3.0, with the REST
Reference Binding, and Invoke REST API activity.

l Updation to Swagger UI: OpenAPISpecification 3.0
support is added to the Swagger UI, which supports the
Swagger 2.0 and OpenAPISpecification 3.0. On invoking the
REST 3.0 service from Swagger UI, the runtime Swagger is
generated as per OpenAPISpecification 3.0.

Note: The OpenAPISpecification 3.0 JSON file containing
OpenAPISpecification 3.0-specific features, which are not in
parity with the Swagger 2.0 JSON file, is not supported.

Encryption and
decryption of application
profiles.

ActiveMatrix BusinessWorks provides capability to encrypt
complete application profiles which can be decrypted while
debugging and at runtime. It helps to increase security for
application properties containing confidential information.
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For more information about encrypting profiles in TIBCO Business
Studio™ for BusinessWorks™, see "Encrypting an Application
Profile" in TIBCO ActiveMatrix BusinessWorks™ Application
Development.

For more information about handling encrypted profiles securely
at the administration side, see "Configuring Application Archives"
in TIBCO ActiveMatrix BusinessWorks™ Administration.

Now you can capture the
details of query
parameters sent as a part
of the incoming request
to a REST service.

Set the following logger in the logback.xml file :

<logger name="com.tibco.bw.binding.rest">
<level value="DEBUG"/>

</logger>

A namespace prefix is
now added for SOAP RPC
Literal response.

The response received from SOAP RPC Literal service was
malformed. Hence the namespace prefix is prepended to the
Response element.

New error code to
represent SOAP
Undeclared Client Fault

The TIBCO-BW-BINDING-SOAP-550101 error code is displayed on
the Invoke activity on receiving Undeclared Client Fault in
response from a SOAP service. In case of server error, the error
code TIBCO-BW-BINDING-SOAP-550100 is displayed.

For more information, see "SOAP Binding Error Codes" in the
TIBCO ActiveMatrix BusinessWorks™ Error Codes .

Support is added for
OAuth 2.0 configuration

This release adds support for OAuth 2.0 configuration on HTTP
Client shared resource for getting OAuth access and refresh
token.

It also adds ability to include access token in outbound REST
reference.

A new OAuth Configuration shared resource is added.

For more information, see "OAuth Configuration Resource" in
TIBCO ActiveMatrix BusinessWorks™ Bindings and Palette
Reference.
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Common Features

Plug-in manager You can now install and uninstall TIBCO ActiveMatrix
BusinessWorks™ plug-ins from TIBCO Business Studio for
BusinessWorks in more simplified way using Plug-in manager.

For more information, see "Installing Plug-ins using
BusinessWorks Plug-ins Manager" and "Uninstalling Plug-ins using
BusinessWorks Plug-ins Manager" in TIBCO ActiveMatrix
BusinessWorks™ Installation.

Administration

Ability to refresh the
status of an
application instance.

The Refresh Agents button is added on page 1 and page 2 of Agents
on the Admin UI.

This button refreshes the status of all AppInstances and AppNodes
running on that particular agent.

Ability to collect and
download AppNode
data.

The new Appnode Data tab is added on the AppNode Level 2 page.

For more information, see "Auto Collecting Engine Data" in TIBCO
ActiveMatrix BusinessWorks™ Administration.

Support is added for
MySQL 8.x.

ActiveMatrix BusinessWorks™ now supports MySQL 8 database. The
options to install the available versions of the driver are listed on the
command line interface.

Note: You can install only one version of the driver at a time. If
you want to install new version, the previously installed driver
version is overridden.

To install the driver for Mysql database, use the bwinstall command
line utility as follows:

bwinstall mysql-driver

To uninstall the driver for Mysql database, use the bwuninstall
command line utility as follows:
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Administration

bwuninstall mysql-driver

For more information, see "Using MySQL 8.x Database" in TIBCO
ActiveMatrix BusinessWorks™ Installation.

Support is added to
dynamically update
flow limit.

This release adds support to dynamically update the flow limit from
the Application level 2, AppSpace level 2, and AppNode level 2 pages
of the Admin UI.

You can also update the flow limit using the REST APIs.

For more information, see "Engine and Job Tuning" in TIBCO
ActiveMatrix BusinessWorks™ Administration

Design Time

Visual Diff You can compare two revisions of a process and its artifacts side by
side visually in TIBCO Business Studio™ for BusinessWorks™. It
highlights changes in newer revision such as addition or removal of
activities, changes in an activity configuration.

l You can compare the application properties sections of two
projects and difference between the two profiles of the same
project.

l You can compare the module properties sections of two
projects.

l This feature supports the visual difference for encrypted
profiles.

l You can compare two revisions of a process.

l You can compare shared resources.

l It provides integration with GIT and SVN to compare revisions
stored in a version control system along with local revisions.

For more information, see "Diff Viewer" in TIBCO ActiveMatrix
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Design Time

BusinessWorks™ Application Development

Sorting functionality
is available for roles.

Now you can move the rows up or down and sort the roles in
ascending or descending order.

Custom Icon is now
introduced for Call
Process and Java
Invoke activities.

The Custom Icon field is added on the General tab for the Call
Process and Java Invoke activities.

For more information see "Call Process" and "Java Invoke" in TIBCO
ActiveMatrix BusinessWorks™ Bindings and Palettes Reference.

For more information on how to add the custom icons, see "Adding
Custom Icons" in TIBCO ActiveMatrix BusinessWorks™ Application
Development.

Support is provided
for module property
for the Client ID on
the JMS Connection.

You can use a module property for the Client ID on a JMS
Connection resource.

Support is added for
application
templates.

Ability to import and export pre-designed application templates
designed with best practices and pre-configured processes, shared
resources, modules etc.

It helps improve collaborative development experience and
reusability where team members can design their applications using
application templates.

You can perform the following operations:

l Export an existing project as a template.

l Create a project using a template

l Modify an existing template.

For more information, see "Working with Templates" in TIBCO
ActiveMatrix BusinessWorks™ Application Development.
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Palettes

The ResourcePath
element is added on the
Input tab of the Invoke
REST API activity.

An additional element ResourcePath is added on the Input Tab of
the Invoke REST API activity for overriding the Resource Path
value on the General tab of the activity.

Support is added for
PostgreSQL failover
URL.

Support is added for PostgreSQL failover URL. For example:

jdbc:postgresql://host1:port1,host2:port2/database

The Loop Subset in
Current Process check
box and the Loop
Subset in Calling
Process field are added
on the Advanced tab of
the JDBC Query
activity.

These options are enabled only when the process in subsets is
selected.

For more information, see "JDBC Query" in TIBCO ActiveMatrix
BusinessWorks™ Bindings and Palettes Reference.

A new Interpret Invalid
XML Chars check box is
added on the Advanced
tab of the JDBC Query
activity.

Select the check box to avoid getting problems with illegal chars.

Now you can enable
Debug level logs for the
Parse JSON and
Render JSON activities.

Now the input and output for the Parse JSON and Render JSON
activities are logged when the Schema Type is selected as XSD on
the General tab, by enabling Debug level logs.

Add the following logger in the logback.xml file :

<logger name="com.tibco.bw.palette.restjson">
<level value="DEBUG"/>
</logger>

Support is added for
the square bracket ([])
in the resource path.

You can pass a query parameter having the square ([]) bracket in
the Invoke REST API activity's Resource Path field on the General
tab or Input tab using percent-encoding for ? as %3F.
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Runtime

Support is added
to collect activity
instance and
process data
instance.

This release adds the ability to collect activity instance and process
data instance.

The activity instance and process instance data is collected from the
AppNode and is stored in a database. The data can be queried by using
REST APIs to find maximum time consuming and maximum memory
consuming activities and processes.

For more information, see "Collecting Performance Parameters with
respect to Activities and Processes" in the TIBCO ActiveMatrix
BusinessWorks™ Administration.
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Changes in Platform Support
In this release, platform support for TIBCO ActiveMatrix BusinessWorks™ has changed as
follows:

Platforms Status As of Release

Apple macOS 10.15.x 64-bit on x86-64 Removed 6.9.1

For a complete list of all the currently supported platforms, see the readme file.
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Changes in Functionality
The following functionality-related changes have been made in this release.

Release 6.9.1

General

Auto-complete fixable after
selecting recommended
elements via existing
internal QF for Smart
Mapper.

For Smart Mapper, after selecting a recommended element
which is a convertible type of the current target element, you
can use the existing internal QF that automatically casts it.
This can help you to avoid an extra click.

Support for Oracle JRE
11.0.18

Earlier, Oracle JRE 11.0.16.0.1 was supported.
Now, Oracle JRE 11.0.18 is shipped with this release.

Administration

Support for
enabling/configuring Profile
Encryption via KeyStore.

The KeyStore file is now uploaded into the ActiveMatrix
BusinessWorks database after enabling/configuring profile
encryption.

Design Time

Provision of creating test
suite/test files for newly created
folders.

Users can now create test suite/test files for newly created
folders under the 'Tests' folder.

Provision of module property
picker for input XML files.

Users are now provided with a module property picker to
provide test input XML files on process starter activities.
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Palette

Enabling basic
authentication for HTTP
Receiver activity sub-paths.

The basic authentication for the HTTP Receiver activity having
sub-paths can be enabled by selecting the Apply Policy to
Subpaths checkbox in the Advance tab.

Change in the cardinality of
Allow header in Send HTTP
Request activity.

The Send HTTP Request activity fails with an "Activity output
data validation" error when invoking a service responding with
a repeated Allow header element.

The cardinality for Allow header field is now set to Repeating
(*) in the Output Editor of Send HTTP Request activity.

Support for OAuth 2.0 with
HTTP Client shared
resources.

OAuth 2.0 is now supported with HTTP Client shared resources
for REST reference binding, Invoke REST API, and Send HTTP
Request.

Runtime

Support for
DSR
command via
Admin CLI.

In TIBCO Business Studio for BusinessWorks, input options are present within
the same DSR command scope. Whereas in Command Line, each input option
of the DSR command now works as an individual command.

Release 6.9.0

Design Time

Support is added for
multiple XSD schemas
with duplicate target
namespaces.

When the user has multiple XSD schemas with duplicate target
namespaces, TIBCO Business Studio™ for BusinessWorks™
application fails to validate them; whereas, when an application EAR
is deployed, it throws an error.

Now, a Preference is added in TIBCO Business Studio for
BusinessWorks application wherein either an Error, a Warning, or an
Ignore option is provided in this scenario.

Enabling Memory The Memory Saving Mode is enabled now by default in Design time



TIBCO ActiveMatrix BusinessWorks™ Release Notes

30 | Changes in Functionality

Design Time

Saving Mode by
default

and Runtime.

Palette

Upgrade to PostgreSQL 6.0
driver.

With this release, PostgreSQL has been upgraded to the latest
6.0 version driver.

Release 6.8.1

General

Updated spring
framework libraries
for Eclipse.

The spring framework libraries for Eclipse are updated to address the
vulnerability issues.

Upgrade the JDK
compiler
compliance version
to the one greater
than 1.5.

The minimum JDK compiler compliance required is 1.5. If the project
that you are importing with Java nature has JDK compiler compliance
less than 1.5, you can choose to upgrade the JDK compiler compliance
version to the one greater than 1.5.

Binding

Support is
added for
Authorize
button on
Swagger UI

Earlier for invoking REST services configured with Basic Authentication Policy
from Swagger UI, you had to provide the Username and Password in the
provided input fields and click the Explore button. Now you can use the
Authorize button and provide the login details.

Runtime

Password Digest option is
provided in SOAP Reference.

You can choose the password type as Password Digest when
using the UserNameToken for security in SOAP Reference.
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Palette

Improved error message for
SOAP Client using HTTP and
HTTPS

Earlier, while invoking a service using HTTPS, the error
message returned by invoke was not very useful to identify
the problem.

Now, an improved error message occurs for SOAP Client
using HTTP and HTTPS.

Release 6.8.0

Administration

Support is added to
enable and disable
OpenTelemetry from
Admin CLI and Admin
UI.

Earlier, support was added to enable and disable OpenTracing from
Admin CLI and Admin UI.

Now, the support is added for OpenTelemetry.

Change in the
content arrangement
in a backup .zip file.

Earlier, while backing up profile, an application profile name used to
change to profile_<application_name><application_version>.substvar
and for appinstance, it used to change to profile_<application_
name><application_version>_<appnode_name>.substvar

Now, in backup .zip file, all the artifacts are arranged in a folder to
maintain exact configurations.

Change in the default
transport layer.

Earlier, the default transport layer between the BWAgent and the
AppNode was UDP.  

Now, the default transport layer is REST.

General

Change in the
default setting
of the Always
run in
background
check box.

Earlier, the Always run in background check box located at Window >
Preferences > General was clear by default.

Now, the Always run in background check box is by default selected.

Clear the check box to view progress bars for some events.
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Palette

A new JMS Fetch
Timeout field is
added.

A new JMS Fetch Timeout field is added on the Advanced tab of the
Get JMS Queue Message activity.

Additionally, the behavior of the timeout field on the Input tab is
changed. For more information, see "Get JMS Queue Message" in TIBCO
ActiveMatrix BusinessWorks™ Binding and Palette Reference.

Support is added
for OpenTelemetry
to collect traces.

Earlier, you could collect traces by using OpenTracing.

Now, you can collect traces by using OpenTelemetry.

For more information, see "OpenTelemetry" in TIBCO ActiveMatrix
BusinessWorks™ Administration.

Release 6.7.0

Administration

Change in the default log level of the
Jetty, Jersey, and MSSQL server (if
applicable) logs.

Earlier Jetty, Jersey, and MSSQL server (if applicable)
logs were available under the BWAgent log when
started in Debug mode.

Now by default, only Warn level logs are present.

You can change the log level of loggers present in the
bwagent_logback.xml.

General

The
TIBCOBusinessStudio.ini
file is present at the
/studio/4.0/eclipse folder
location on Mac operating
system.

Earlier the TIBCOBusinessStudio.ini file was present inside
TIBCOBusinessStudio.app folder.

Now from TIBCO ActiveMatrix BusinessWorks™ 6.7.0, the
TIBCOBusinessStudio.ini file is present under eclipse folder.

Change in the deployment
method name

The name of the deployment method is now changed from
"Appspace" to "BW Appspace".
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General

Change in a way to discover
application server URL.

When TIBCO ActiveMatrix BusinessWorks™ application with
REST reference and with Mesh service client enabled was
launched from TIBCO Business Studio™ for BusinessWorks™,
the application invoked a Mesh service from the application
on an application server. The application server's URL was
determined by fixed rules.

After a fully-qualified domain names (FQDN) service is
provided, when the ActiveMatrix BusinessWorks™ application
is launched, TIBCO Business Studio for BusinessWorks
accesses the FQDNs and discovers the application server URL
from it using a domain URL.

EGIT plug-in installation There is no need to install EGIT plugin manually.

EGIT plug-in version 4.4.1 is now a part of TIBCO Business
Studio for BusinessWorks itself.

To verify the installation, navigate to Help > Installation
Details > Plugins (Egit).

Migration

Addition of the module
name as a prefix to the
custom Xpath function

Earlier, after migration, the customxpathfunction jar-name did not
have prefix of the module name in it and it migrated as a plain
customxpathfunction jar for the custom Xpath functions.

Now, the CustomXpathFunction jar that is generated by the
migration tool contains the name of the module as prefix before
the customxpathfunction jar name.

For example, in SampleApplication_CustomXpathFunction.jar,
SampleApplication is the module name.
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Deprecated and Removed Features
This section lists the features that have been deprecated or removed in this release.

Deprecated Features

Release 6.9.1

l Support for Progress DataDirect drivers has been deprecated with this release.

Release 6.9.0

l The Profile Encryption feature is deprecated in the TIBCO Business Studio for
BusinessWorks.

Note: The Profile Encryption feature is now governed by a preference
named "Profile Encryption". The preference is available at Window >
Preferences > BusinessWorks > Profile Encryption. By default, it is
disabled. You can use the feature by enabling it via the above-mentioned
preference.

Release 6.8.1

l Writing Process Statistic Data to an External Database using logback file is
deprecated.

l The Password Grant feature is deprecated.

l The Analyzer feature is deprecated.

Release 6.8.0

l TLS v1 and TLS 1.1 support is deprecated.

l Support for third-party JMS drivers which are JMS 1.1 compliant by using the Custom
JMS driver approach is deprecated.

Release 6.7.0

l The Universal Installer for TIBCO ActiveMatrix BusinessWorks™ will not include out of
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the box support for SVN from the next release. TIBCO will provide a separate
documentation with respective release on how to install the SVN plug-in.

l Maven plug-in will not be shipped with ActiveMatrix BusinessWorks™ 6.x. Maven plug-
in installation option from the bwinstall scripts is removed.

Removed features

Release 6.9.1

l The Profile Encryption feature in TIBCO Business Studio for BusinessWorks has been
removed from this release.

Release 6.9.0

l The Password Grant feature has been removed in this release.

l The Analyzer feature has been removed in this release.

Release 6.8.1

No feature has been removed from this release.

Release 6.8.0

With TIBCO ActiveMatrix BusinessWorks™ 6.8.0 release, OpenTracing libraries are removed.

TIBCO ActiveMatrix BusinessWorks™ 6.8.0 now includes OpenTelemetry support for tracing.
All OpenTelemetry compliant service providers can be integrated to show traces for
ActiveMatrix BusinessWorks applications.

For more information, see the "OpenTelemetry" in TIBCO ActiveMatrix BusinessWorks™
Administration.

ActiveMatrix BusinessWorks removes out-of-the-box support for SVN.

Release 6.7.0

No feature has been removed from this release.
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Closed Issues
The following are the closed issues in this release of TIBCO ActiveMatrix BusinessWorks™.

The closed issues are grouped by components:

l Administration

l Binding

l Core Design Time

l Core Runtime

l General

l Migration

l Palette

l Policies

Administration
This topic lists the closed issues related to Administration.

Release 6.9.1

Key Summary

AMBW-45898 The "USERNAME" column is missing in the
CommandHistory table of the Oracle CreateSQL script
for LINUX installation.

Release 6.9.0
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Key Summary

AMBW-43962 Multiple occurrences of query calls to retrieve
AppSpace from TIBCO® Enterprise Administrator or
bwadmin console have been reduced to minimize
delay and improve performance.

AMBW-34773 Admin UI displays promoted module properties for an
application as undefined%.

Release 6.8.1

Key Summary

AMBW-45498 Now the TEA Activity Instrumentation Panel can
display all the activities.

AMBW-45121 The database query to update the AppInstance status
has been optimized to improve database
performance.

Release 6.8.0

Key Summary

AMBW-
44051

The database query to update the AppInstance status has been optimized to
improve database performance.

AMBW-
42939

A BWAgent fails to start when using SSL with wildcard certificates.

AMBW-
42938

The process id value for an AppNode present in the output of an API server URL
does not change even if you restart the AppNode.

AMBW-
42899

The BWAdminDataManager is not yet initialized error is displayed when you
try to update the profile using the bwadmin config command with -cf option.

AMBW- The BWAgent's query working with TEA uses bind variables in the query on the
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Key Summary

42130 Oracle database.

AMBW-
34574

There was a harmless warning when starting BWAgent.

Release 6.7.0

Key Summary

AMBW-
40946

User were not able to download the Log and Logback files from Admin UI.

AMBW-
40794

The swagger response was different than the actual response of the Deploy
Application API.

AMBW-
40712

The Javascript core libraries are updated to the latest version.

AMBW-
40586

The Get Application Status REST API displayed the 500 internal server error when
an application was in the Starting state.

AMBW-
40027

Updating the Password field from Admin UI was not working when the provided
password had the percentage character (%).

AMBW-
39972

The application instance properties could not be restored to their original values
when they were modified through Admin UI.

AMBW-
39511

Create domain at the custom location was not working from REST API.

AMBW-
37423

After upgrading, too many unnecessary errors were displayed when starting the
BWAgent.

AMBW-
36613

The upload and deploy profile took too much time.

AMBW-
34574

There was a harmless warning when starting BWAgent.
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Binding
This topic lists closed issues related to Binding.

Release 6.9.1

Key Summary

AMBW-48168 When migrating TIBCO ActiveMatrix BusinessWorks 5.x SOAP
project to 6.x, the input mappings on the Invoke activity are
lost, causing an issue while invoking the SOAP service.

Note: The input of the "_configData" element from the
ActiveMatrix BusinessWorks 5 project must be provided as
an input in the SOAP Reference Binding -> Request Context
-> endpointURI field.

AMBW-48167 An error "TIBCO-BW-FRWK-400030: Error destroying binding
[RestService1], <CausedBy> java.lang.NullPointerException" is
thrown after the application restart when some changes are
made to an already running application having multiple REST
services with similar resource service paths.

AMBW-48157 The anyType element in the input editor of the SOAP service,
which is expected to receive any kind of requested XSD data
structure is not mapping the received data in any element,
resulting in an empty output from OnMessageStart.

AMBW-48028 The Error Code is not reflected in the FaultDetails/MsgCode
element when a REST service fails due to a bad request.

AMBW-48017 Data types are missing during the Generation of XSD from the
Swagger file containing JSON schema object with properties
referring to other models.

AMBW-47607 To address security vulnerabilities in the snakeyaml-1.33.jar
file, the SnakeYAML jar has been updated to version 2.0.

Release 6.9.0
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Key Summary

AMBW-46622 Invoking SOAP service fails with "Failed to initialize
SoapReferenceBinding - TIBCO-BW-SCHEMA-RESOLVER-500201:
WSDL not found" error.

AMBW-46604 The ProcessStack field under the FaultDetails tab is not
populating the correct Process Name in the fault details when
the process has two service bindings with the same operation.

AMBW-46557 The XML parser in TIBCO ActiveMatrix BusinessWorks™ does
not recognize the boolean value and treats it as a whitespace.

AMBW-46371 On installing TIBCO ActiveMatrix BusinessWorks™ 6.7.0 HF-005,
whitespaces are getting trimmed in the output.

AMBW-46046 When a process has multiple reference bindings with "Enable
DefaultFaultElement" and "Enable CustomFaultElement"
selected ONLY in one of the bindings, the fault in the Catch
block throws design-time errors.

AMBW-22981 When invoking a REST service's GET operation with Content-
Type as "application/json" having response as "string" type,
the response content-type changes to "text/plain".

Note: If an invalid JSON i.e. a simple string is provided in
the response, the Swagger UI shows a parsing-related error,
"can't parse JSON. Raw result:" along with the response
value; which is the expected behavior. The response value
must be configured with the correct JSON format, for
example:

{"name": "abc"}

Release 6.8.1

Key Summary

AMBW-45639 When Invoke activity with REST Reference binding is configured
with absolute file path for multipart form parameters, it deletes
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Key Summary

the files that are passed as mimePart input.

AMBW-45520 For bypassing the version validation in TIBCO Business Studio
for BusinessWorks for swagger files having openapi version
other than 3.0.0, pass the property
bw.plugin.rest.disableOpenApi3xVersionValidation=true
in the TIBCOBusinessStudio.ini file.

AMBW-45399 The application fails to start intermittently and throws an error
"TIBCO-BW-SCHEMA-RESOLVER-500201: WSDL not found".

AMBW-45155 The Runtime Swagger file does not include enumeration
restrictions which are defined in a request and response XSD
configured with the REST service.

AMBW-45154 The Runtime Swagger file of a REST service has optional
extension elements declared in the XSD as required.

AMBW-45153 The Runtime Swagger file does not include field length
restrictions which are defined in a request and response XSD
configured with the REST service.

AMBW-43403 The XSD generation, and Service or Reference binding creation
operation are no more blocked, by avoiding parsing of
"#/components/examples".

Release 6.8.0

Key Summary

AMBW-43816 For REST application deployed on an AppNode, the bw-flowlimit-
executor-provider threads are not destroyed and keep on
increasing even after starting and stopping an application.

AMBW-43397 You can now decide whether to send SOAP headers or not in the
SOAP Envelope of the service. Set the -
Dbw.binding.soap.client.invoke.send.headers property as a
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VM argument in TIBCO Business Studio for BusinessWorks or in
the config.ini file to false to stop sending SOAP headers.

By default, the property value is set as true.

AMBW-43238 Empty header is passed in response in the SOAP envelope even if
you don't configure the SOAP service with Headers.

To not send empty headers set the property
bw.binding.soap.client.reply.empty.header.override=true.

AMBW-42775 The "definitions" section in the runtime Swagger file does not
show the type as "array" for the child properties of an object
when you run a REST service configured with a complex element
in an XSD, and the element's definition in the XSD contains
<xs:extension> element with base attribute and array-based sub-
elements.

AMBW-42550 The operationID field is now displayed in the runtime Swagger file
of a REST service when it is hit from Swagger UI.

AMBW-42313 The Configure Local Swagger option does not work when you
import a project in TIBCO Business Studio for BusinessWorks first
and then configure the Local Folder path in the API Explorer tab.

AMBW-27634 The null pointer exception is thrown while adding the SOAP
Unbound Headers.

Release 6.7.0

Key Summary

AMBW-
41468

After migration, the org.apache.axiom.om.OMException: Unable to determine
SOAP version error occurred when an attachment style was MTOM.

Add the following property:

bw.binding.soap.client.reply.mtom.contenttype.override=true.
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Key Summary

AMBW-
41299

The unbound header parts were missing in the concrete WSDL generated at
design time using the Generate Concrete WSDL option from SOAP service, which
imported another WSDL importing request and response header XSDs.

AMBW-
41129

The Apache Axis2 threads were not increased with an increase in load.

AMBW-
40680

The Unbound Header parts were missing in the runtime concrete WSDL retrieved
from SOAP service with version 1.2.

AMBW-
40679

The Unbound Header parts were missing in the runtime concrete WSDL retrieved
from a SOAP service when the abstract WSDL imported another WSDL, and the
WSDL imported request and response header XSDs.

AMBW-
40484

The Send HTTP Request activity could not send the request with Content-type as
multipart/form-data to ServiceNow with Apache HttpComponents library.

Send the POST request using the Jetty HTTP Client library in the HTTP Client
shared resource.

AMBW-
39997

The incorrect error code 403 Forbidden was thrown for the Invoke activity in a
SOAP over HTTP application when the HTTP Client shared resource was
configured with the following options:

l Default port = 443

l Implementation Library = Apache HttpComponents(Supported by HTTP 1,
SOAP and REST)

l Default Confidentiality check box was selected.

AMBW-
39819

The time required for runtime concrete WSDL retrieval for a SOAP service
increased if more applications with a large number of schemas were deployed on
the same AppNode.

AMBW-
39038

The runtime concrete WSDL took too much time to generate when an endpoint
was hit in the browser, because the schema cache was not initialized before
WSDL retrieval.
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Core Design Time
The following issues have been fixed in this release of TIBCO ActiveMatrix BusinessWorks™.

Release 6.9.1

Key Summary

AMBW-
48034

The previously saved changes from the "Export-Package" section in the
manifest.mf file are removed when modification is done in the projects.

AMBW-
47723

A Null pointer error is thrown when promoting module properties with no/empty
default value.

AMBW-
47541

TIBCO Business Studio for BusinessWorks throws a StackOverflow error when it
builds the workspace after importing a specific project.

AMBW-
47019

When updating the XSLT version from 1.0 to 2.0, errors are thrown as "Invalid
conversion from string? | string? to item" relating to type-casting values from one
type to another.

AMBW-
34062

An error is thrown when running an application having additional space in the
element name of the schema.

BWCE-
5423

While creating a new custom xpath function, the activator class does not get
generated even if the Generate Activator Class check box is selected.

BWCE-
5385

When the pom.xml file is generated for an application, it refers to an older version
of "com.tibco.bw.palette.shared" jar.

BWCE-
5352

Iterate cannot be used in a group over a list when the elements are derived from
abstract types to map inputs, because it does not have the variable type
configured in the currentElement.

BWCE-
5297

While using the Maven plug-in, when there are redundant dependencies
configured in the pom.xml file of an application, the workspace keeps displaying
the message "Validating External Shared Modules from Maven Dependencies"
indefinitely.
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Release 6.9.0

Key Summary

AMBW-
46540

When you add external JAR files in Shared Module, the Export-Package entry from
the manifest.mf file is removed.

AMBW-
45943

When you rename a module or application property group as "Application",
TIBCO Business Studio for BusinessWorks crashes. It is a reserved keyword now
and a validation error message is displayed.

BWCE-
4847

When application modules have any external dependencies such as shared
modules and custom xpath functions, these dependencies do not get imported
automatically into the workspace.

BWCE-
4726

A validation error is thrown when an activity has invalid name and the error
message is not clear.

Release 6.8.1

Key Summary

AMBW-
45923

For certain projects, TIBCO Business Studio for BusinessWorks displays a
misleading error in the Problems tab as follows:
Inline schema is not cloned correctly.

AMBW-
45716

The Keystore Provider URL field when mapped as a module property continues to
throw an error even when user corrects a previous invalid/incorrect value. Now a
warning message is shown for this field irrespective of the mapping being module
property or literal value.

AMBW-
45682

Whenever there are multiple transitions to the End activity, a new variable with
an optional error report type is created and that variable takes precedence over
the normal error variable.

AMBW-
45326

An error is thrown when you try to start an application when using the remote
debugging feature in TIBCO Business Studio for BusinessWorks.
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Key Summary

AMBW-
42932

Selecting the Generate Process Diagrams check box does not generate the
process diagram in the application module.

AMBW-
36625

When there are validation errors in a ActiveMatrix BusinessWorks application, they
are not reported by the bwdesign utility when using the Validate option.

AMBW-
28561

You can use TIBCO ActiveMatrix BusinessWorks Maven plug-in to integrate the test
reports, which are generated with the CI/CD tools like Jenkins.

Release 6.8.0

Key Summary

AMBW-44487 While performing the Push to Cloud action from TIBCO
Business Studio for BusinessWorks, the EAR generation
operation does not time out for large projects.

AMBW-44475 ActiveMatrix BusinessWorks throws an error  when mapping
the JDBC Query activity's output to the Iterate group.

AMBW-43710 On running an application, the Activity output data
validation error is displayed when the JDBC Query activity is
used with the Iterate group.

AMBW-43195 The system:validate command throws an error and returns
incorrect status code for some projects.

AMBW-43138 TIBCO Business Studio for BusinessWorks becomes
unresponsive intermittently when you import a shared
module through maven plug-in.

AMBW-43109 TIBCO Business Studio for BusinessWorks throws the Value
for context variable is null error at runtime for some projects.
Now a Quick Fix option is available which shows the Invalid
context variable configuration error on the Problems tab
when you import a project in TIBCO Business Studio for
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Key Summary

BusinessWorks for the Get Context activity.

After applying the quick fix, the error is not displayed and
you get a successful response.

AMBW-43026 After renaming a process package, the Input tab of the Call
Process activity is not displayed.

AMBW-42293 The XSLT is out of sync with schema component
properties error continues to occur even after a quick fix is
applied post-migration.

AMBW-42115 The last modified date of an API in the API Explorer tab is
incorrect.

AMBW-42089 TIBCO Business Studio for BusinessWorks displays incorrect
build order of modules when the projects are imported using
the bwdesign utility.

Release 6.7.0

Key Summary

AMBW-41298 The Iterate group for a schema element did not work when
the element belonged to a no-namespace schema.

AMBW-40453 Support for migration of the tib:evaluate function is
provided in TIBCO ActiveMatrix BusinessWorks™ 6.7.0.

AMBW-40436 TIBCO Business Studio™ for BusinessWorks™ displayed null
pointer exception when constructing the
CatchAllFaultDetails document because of the incorrect
transition link from the Scope.

Now, the following error message is displayed whenever
there is a link in the process that has the source activity set



TIBCO ActiveMatrix BusinessWorks™ Release Notes

48 | Closed Issues
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as the group end activity.

Outgoing link from Group End activity of <group_name>
group is incorrectly configured. Please delete and recreate it
to repair or apply the quick fix.

Applying the quick fix deletes the erroneous link and
recreate the link with the correct serialization.

AMBW-40295 TIBCO Business Studio for BusinessWorks did not select sub
processes correctly in the Run Configuration and Debug
Configuration windows.

AMBW-39820 TIBCO Business Studio for BusinessWorks did not display
appropriate error for a transition from the Group End activity
to any activity inside the Group.

AMBW-38966 TIBCO Business Studio for BusinessWorks failed to generate
.EAR from studio and bwdesign utility due to null pointer
exception.

AMBW-38787 TIBCO Business Studio for BusinessWorks displayed an error
in the Problems tab when a module property inside a
shared module referred a process property of type JDBC
Connection.

AMBW-38748 Leading or trailing white spaces from alias name of SSL
server shared resource did not trim when the value type was
literal value.

AMBW-38292 Null pointer exception occurred while generating .EAR for
specified customer project.

AMBW-37808 While moving the JMS shared resources from an application
module to a shared module, TIBCO Business Studio for
BusinessWorks didn't refactor the module property path
correctly.

(Continued)
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Key Summary

AMBW-37597 The Job Data view in the debugger became unresponsive
while displaying large data.

AMBW-37112 The validation message was not displayed on using the
parallel JDBC activity inside the Local Transaction group.

AMBW-34133 The Iterate group configuration error because of schema
used does not have namespace. error reported if the Iterate
group used schema without namespace.

(Continued)

Core Runtime
The following issues have been fixed in this release of TIBCO ActiveMatrix BusinessWorks™.

Release 6.9.1

Key Summary

AMBW-
48181

The activator process is slow when running an activity with large XML data in
Debug mode.

AMBW-
43215

For the SAP application, If the SAP component is not available, then the
application goes into an impaired/start failed state.

Release 6.9.0

Key Summary

AMBW-
46544

Application deployed to AppSpace configured in FT-group mode and FTL as group
provider activates more than one active instance on restarting FTL servers
configured in FT mode.

AMBW- When Appnodes are configured in FT-group, the wrong Component status is
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Key Summary

46534 shown differently on TIBCO® Enterprise Administrator UI and via REST API calls.

AMBW-
46530

SOAP/JMS service throws an error, "cache cannot be null.stacktrace :
java.lang.AssertionError: cache cannot be null" when the JMS receiver configured
to the queue has a lot of pending messages more than the relative flow limit set
for the component.

AMBW-
46514

Heap memory increases due to memory leaks while using Notify and
ReceiveNotification activities.

AMBW-
46502

At runtime in ftgroup mode with weighted property, when the application
contains a service-based sub-process call in a process, the Fault Tolerance
mechanism stops working post secondary fail-over.

A property named "bw.engine.ftgroup.activator.servicesubprocess" is now
provided to fix this issue.

AMBW-
46207

Applications with subprocess calls without the Spawn option are moving into an
unresponsive state in group persistence appspaces because of logical deadlock.

AMBW-
45361

The stopapp/startapp OSGi commands are not working in TIBCO ActiveMatrix
BusinessWorks™ 6.7.x and 6.6.x code bases.

AMBW-
39684

An "Attribute DataType cannot be null" error occurs when coercion is used for the
"anyType" element in the iteration loop.

AMBW-
36995

Variables inside the iterate loop do not reset after each iteration when they are
not executed again.

Release 6.8.1

Key Summary

AMBW-
44222

The module shared variable fails to reset to initial value on restarting an
application.

Release 6.8.0
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Key Summary

AMBW-
44452

When migrating the ActiveMatrix BusinessWorks application from 6.4.1 to 6.6.0,
the JobsharedVariable defined in a module is not recognized by other modules of
an application.

AMBW-
44451

Two applications incorrectly refer to the same hashmap in some cases when an
AppNode starts the applications at the same time, and an activator process is
used along with custom XPath functions.

AMBW-
44450

For Group mode, if the AppNodes are unresponsive for more than 31 seconds
then the process starter activity is disabled for the AppNodes which results in
AppNodes are marked as inactive by the reco..///very system.

Set the com.tibco.bx.engine.recovery.failure.threshold property to a value
between 31 to 180 seconds.

TIBCO ActiveMatrix BusinessWorks SharedVariable does not reset to initial value
after deployed application restart.

The module shared variable failed to reset to initial value on restarting an
application.

AMBW-
43980

ActiveMatrix BusinessWorks application containing the FTL Subscriber activity
having flowlimit set along with engine threads displays the out of memory error
when the number of transactions per second are increased above 50.

AMBW-
43770

The JMS Receive Message activity running on an AppNode with the Group mode
fails to start when a BWEngine resumes from the Suspended state.

AMBW-
43221

The Wait and Notify activities in the group persistence mode do not work with
default values for the bw.engine.threadCount and bw.engine.db.maxConnection
properties.

Set the following new properties in the AppSpace's config.ini file:

com.tibco.bx.lockWaitNotify=true
com.tibco.bw.throttle.notify.activity=true
com.tibco.bw.throttle.wait.activity=true

Use the throttle properties when default configuration is used .
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The bw.engine.db.maxConnection property's value must be greater than the
bw.engine.threadcount value.

AMBW-
43220

Some of the ActiveMatrix BusinessWorks jobs are not processed intermittently
when an application has Wait and Notify activities.

To avoid the deadlock scenario, TIBCO recommends to set the
com.tibco.bx.lockWaitNotify=true property and the value of
bw.engine.db.maxConnection property = twice the value of
bw.engine.threadCount.

AMBW-
43102

On stopping the application, an application cannot call the delete method of the
shared resource when the shared resource uses module property in one of the
fields.

AMBW-
43101

The BW.MODULE.NAME and BW.MODULE.VERSION module properties return empty
values.

AMBW-
43099

The Iterate group in a subprocess generates incorrect output when two different
processes call the same subprocess containing the Iterate group at the same
time.

AMBW-
42919

After new installation and setup of AppSpaces and the AppNodes, the AppNodes
that have "group" settings cannot start and display the following error: Unable to
find CheckpointModelFactory: DB.

AMBW-
42506

Modifications done inside a running application in TIBCO Business Studio for
BusinessWorks displays the Process not found error.

AMBW-
42106

AppNode APIs now provide complete stack trace in a thread dump.

AMBW-
41286

TIBCO Business Studio for BusinessWorks throws NullPointerException while
running a project with different nested subprocesses.

Release 6.7.0
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Key Summary

AMBW-
41486

The <?xml-multiple?> tag disappeared from the output of the Parse XML activity
when the Validate Output check box was selected.

Set the -Dbw.application.activity.validateOutput.treeValidation=true
property as VM argument to add the tag when validating an output XML.

AMBW-
41289

The <msgCode> tag under FaultDetails could not capture the actual msgCode
value.

AMBW-
41222

An application was unable to resolve a process variable on startup for the Assign
activity, even though the Call Process activity in the same process could resolve
the same process variable.

AMBW-
41218

The Engine Command activity did not stop an application when an application
was restarted.

AMBW-
41207

Memory leak issue was observed due to an instance of to
org.eclipse.xsd.XSDSchemaDirective[] on an AppNode.

AMBW-
41045

After upgrading, the Transform XML activity took more memory and generated
the Out of Memory Exception.

AMBW-
40793

An application could not be started when its status was STARTFAILED.

AMBW-
40362

An application using WSDL from a shared module failed to restart and displayed
the java.lang.IllegalStateException: BundleContext is no longer valid error.

AMBW-
40232

The conversation handler failed when multiple AppNodes were set up in a group
persistence mode.

AMBW-
40145

Ability to evaluate transition expression as XPath 1.0 expression

Set the bw.engine.use.transition.xpath.expression.lang.1.0 property to true
in the AppNode's config.ini file.

By default, the value is false.

AMBW- The performance was degraded in the Iterate Group activity.
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Key Summary

38813

AMBW-
36149

When an application had a persistent shared module in the group mode, the
following error occurred intermittently:

PVM-MODEL-102700.

AMBW-
33830

After migration, the Repeat group used in a calling process displayed
java.sql.SQLException when the JDBC Query activity was configured with a
process in subsets used inside a subprocess.

General
This topic lists the closed issues related to General issues.

Release 6.9.1

Key Summary

AMBW-
48156

The dateTime() function throws "[FORG0001] Invalid value for cast/constructor"
error for the input value “xsd:dateTime("2022-12-20T17:14:50.Z")”.
Set the property -Dbw.xml.datetime.allowMissingFracSeconds=true to
overcome the error while parsing the date and time for the input value. By
default, this property is false.

AMBW-
47854

Application with an iterate group running in Debug mode throws an Out of
memory error.

AMBW-
47303

In the ActiveMatrix BusinessWorks 6.6.1 release notes, the wrong syntax,
bw.application.activity.validateInput[.<ApplicationName>
[.<ApplicationVersion>][.<ModuleName>.<ProcessName>[.<ActivityName>]]]
to support turning off XML validation up to activity level was mentioned.
The correct syntax for the system property that has to be set at the appnode level
to turn on/off XML validation at the activity level is
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bw.application.activity.validateInput[.<ApplicationName>
[.<ApplicationVersion>][.<PackageName>.<ProcessName>
[.<ActivityName>]]].

AMBW-
46900

To address security vulnerabilities, the maven-shared-utils-3.2.1.jar file has
been upgraded to CVE-free maven-shared-utils-3.3.3.jar in assembly_tibco_
com_tibco_org_eclipse_maven_feature_p2.

AMBW-
36024

Tests tab and icon shown for mocked activities are missing when importing a
project configured using Maven in a workspace.

Release 6.9.0

Key Summary

AMBW-
46579

When an integer value is mapped to a decimal element, the fractional values are
always present even though there is no fractional part in the mapping.

AMBW-
46474

TIBCO Rendezvous® (RV) projects throw NullPointerException with version RV
8.6.0.

AMBW-
45744

The Timer Trigger process blocks when the EMS connection is lost.

AMBW-
44570

TIBCO ActiveMatrix BusinessWorks™ throws an error when a long-type value is
mapped in the "int" type for XPath.

AMBW-
40485

The XSLT Transform activity fails to recognize and transform certain data from the
input XML string.

AMBW-
28277

The XSLT Transform activity skips certain data from the input XML string.

BWCE-
4934

A ClassNotfoundexception occurs during Maven testing when a shared module
has a Java class and it is called using the Java Invoke activity.

BWCE-
4848

The Maven plug-in does not pick dependency versions from the parent pom.xml
file.
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Release 6.8.1

Key Summary

AMBW-
45819

TIBCO ActiveMatrix BusinessWorks plugin for Apache Maven does not resolve the
transitive dependencies when you create an EAR using the mvn package
command.

AMBW-
45489

If you provide any character in the Fill With field of the Data Format shared
resource and then use the shared resource along with the Render Data or the
Parse Data activities, ActiveMatrix BusinessWorks adds the 'O' character in the
activity output instead of the character provided by you.

AMBW-
45457

Any element in output editor or RVSubscriber which is expected to receive any
kind of requested XSD data structure is not mapping received data in any
element, resulting in empty output from RVSubscriber.

AMBW-
45449

The Rendezvous Subscriber activity fails to process messages that are generated
with the third-party Rendezvous publishers.

AMBW-
45414

Unable to map the iterator element value on transition post-migration.

AMBW-
44957

The context-sensitive help for TIBCO Business Studio for BusinessWorks is not
currently available in ActiveMatrix BusinessWorks 6.8.0.

AMBW-
44034

The JDBC Query activity result set adds extra space in the output for a field that is
empty in the database.

Release 6.8.0

Key Summary

AMBW-
44449

Transition condition with boolean value is not evaluated correctly against String
true.

Add the new -
Dbw.xml.comparable.legacy.booleanStringEquality=true property as a VM
argument along with the -
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Dbw.engine.use.transition.xpath.expression.lang.1.0=true property in
TIBCO Business Studio for BusinessWorks

AMBW-
44448

Empty tag is not generated for optional-nil elements.

Now, a new Treat optional-nil elements as optional elements check box is
added on Window > Preferences > Mapper page. Select the check box and clean
the workspace.

After cleaning the workspace, you get some XSLT out-of-sync errors on the
Problems tab. Use the Quick Fix option to resolve those errors and execute the
project again to generate empty tags for the optional-nil elements.

AMBW-
44435

Input and Output schemas are not formed correctly when creating a Mesh client
for a ActiveMatrix BusinessWorks and TIBCO Flogo Open API Specification 3.0
Mesh Service.

AMBW-
44434

After Tibtunnel recovers from its termination, ActiveMatrix BusinessWorks cannot
connect to the on-premise resources such as Enterprise Message Service (EMS) for
one round of Timer trigger.

AMBW-
44350

ActiveMatrix BusinessWorks consumes a large memory heap and throws the out
of memory error when you read a file using the Java Invoke activity.

AMBW-
44305

If you select the Generate Implementation Specification check box, the REST
service binding binds properly with the newly generated Swagger specification
and the same specification appears in the Manifest.json while exporting the
application EAR. 

AMBW-
44090

ActiveMatrix BusinessWorks does not display expected elements, if any, when an
unexpected element is encountered while validating an XML document against a
schema.

AMBW-
43867

Oracle JDK 11.0.12 is now bundled with this release of ActiveMatrix
BusinessWorks.

AMBW-
43209

When an XSLT transformation fails, the stack trace does not show the element
that fails during the transformation and the cause of the failure on the Render
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JSON activity.

AMBW-
43104

The Write File activity cannot generate a file when the TextContent field has the
space character (" ") value.

AMBW-
43100

The literal white space character ('') is not datatype-valid with
respect to the datatype definition '
{http://www.w3.org/2001/XMLSchema}double'. error is displayed in mapper.

To avoid typecasting error, use the following VM argument:

-Dbw.xml.general-comparison.ignore-numeric-cast=true

AMBW-
43098

An application throws an error when an activity's XPath contains the insert-
before() function.

AMBW-
43097

The whitespace characters (' ') are trimmed in a string field of the Mapper
activity.

AMBW-
43044

The bwdesign utility shows the NLS unused message warning when exporting a
project.

AMBW-
42903

A SOAP service having the Reply activity throws the following error for an error
configured on the Reply activity when the Reply activity has an input value
mapped to the Description field:

$$$$$ ERROR occurred while converting between Axiom and BW preferred
node type.

AMBW-
42657

You cannot add the duplicate When condition along with its expression if you use
the Surround with Choice option for an element, and then try to duplicate the
When condition.

AMBW-
42568

An application throws an error on design time and runtime when an activity's
XPath contains the min() and max() function. A new Quick Fix option is provided
to resolve the error.

AMBW-
41646

Smart Mapper cannot create a For Each statement for a repeating element.
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AMBW-
34798

The $ParseXml/primitive>sum($ParseXml/NewElement) expression generates
incorrect results with XPath 2.0 when the following VM arguments are set in
TIBCO Business Studio for BusinessWorks: -
Dbw.application.activity.validateInput=false and -
Dbw.application.activity.validateOutput=false

AMBW-
33760

Transition expression is not saved in MAC OS.

AMBW-
33562

TIBCO Business Studio for BusinessWorks does not show the job data when
debugging an application in the debugger

Release 6.7.0

Key Description

AMBW-
41613

The activity input data validation error occurred when converting a double value
to a decimal value and the -Dbw.application.activity.validateOutput=false
property was set in the config.ini file.

A new -Dbw.xml.decimal.allowDoubleExponent property is added.

Set the -Dbw.xml.decimal.allowDoubleExponent property to true along with the
-Dbw.application.activity.validateOutput=false in the config.ini file.

AMBW-
41486

The <?xml-multiple?> tag disappeared from the output of the Parse XML activity
when the Validate Output check box was selected.

Set the -Dbw.application.activity.validateOutput.treeValidation=true
property as VM argument to add the tag when validating an output XML.

AMBW-
41289

The <msgCode> tag under FaultDetails could not capture the actual msgCode
value.

AMBW-
41223

The trim() mapper function in the Group by clause failed and generated the
XSLT transformation error at run time.

AMBW- An application was unable to resolve a process variable on startup for the Assign
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41222 activity, even though the Call Process activity in the same process could resolve
the same process variable.

AMBW-
41221

The input tab mappings were not visible for activities when the if condition in
the XPath function was empty.

AMBW-
41218

The Engine Command activity did not stop an application when an application
was restarted.

AMBW-
41207

Memory leak issue was observed due to an instance of to
org.eclipse.xsd.XSDSchemaDirective[] on an AppNode.

AMBW-
41045

After upgrading, the Transform XML activity took more memory and generated
the Out of Memory Exception.

AMBW-
40860

The coercion failed to fetch the correct elements for mapping and displayed a
validation error at design time when there were two elements of the same name
and namespaces, but from the different schemas.

AMBW-
40793

An application could not be started when its status was STARTFAILED.

AMBW-
40362

An application using WSDL from a shared module failed to restart and displayed
the java.lang.IllegalStateException: BundleContext is no longer valid error.

AMBW-
40232

The conversation handler failed when multiple AppNodes were set up in a group
persistence mode.

AMBW-
40145

Ability to evaluate transition expression as XPath 1.0 expression

Set the bw.engine.use.transition.xpath.expression.lang.1.0 property to true
in the AppNode's config.ini file.

By default, the value is false.

AMBW-
39898

The XSD resolver could not process the id attribute in the xs:group element.
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AMBW-
39494

Summary: The current-dateTime() function returned different representation of
output in TIBCO Cloud Integration, ActiveMatrix BusinessWorks, and TIBCO
ActiveMatrix BusinessWorks Container Edition.

AMBW-
38971

After migration, coercion disappeared and had to be remapped frequently.

AMBW-
38813

The performance was degraded in the Iterate Group activity.

AMBW-
36149

When an application had a persistent shared module in the group mode, the
following error occurred intermittently:

PVM-MODEL-102700.

AMBW-
36034

An application was not visible in the Debug Configuration window when the
project's name was different than the value of the ID field of the Overview section
of the project.

AMBW-
33830

After migration, the Repeat group used in a calling process displayed
java.sql.SQLException when the JDBC Query activity was configured with a
process in subsets used inside a subprocess.

Migration
This topic lists the closed issues related to Migration.

Release 6.9.1

Key Description

AMBW-
48159

The RV publisher activity does not honor special keyword characters like "_plus_"
and "_sp_" in the element name post Migration.

AMBW-
47732

GV mapped to the JDBC activity timeout and Maximum rows are not showing up
in ActiveMatrix BusinessWorks 5.x to 6.x migrated code.
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The "Timeout (secs)" and "Maximum rows" fields in the JDBC Call Procedure
activity do not display the mapped module property value post migration but
display the default literal values.

AMBW-
32780

The REST Dispatch and Reply activity in ActiveMatrix BusinessWorks 5.x is
migrated to the Invoke Rest API activity instead of the REST Service Binding.

Release 6.8.1

Key Description

AMBW-
44538

After migration, the element inside the Catch all > error_variables are not
resolved correctly when a process with more than one fault element is configured
in the End activity.

Release 6.8.0

Key Description

AMBW-
43791

After migration, the mapper input is empty when the schema is referenced from
data format shared resource.

AMBW-
43501

The migration tool migrates processes with the REST-Dispatch-and-Reply activity
to a REST resource. In TIBCO ActiveMatrix BusinessWorks™ 5.x, the service
processing logic is delegated to a subprocess as per operation. Normally the
subprocess is migrated. To supplement this, a call process is created to invoke
that subprocess in the REST resource.

You may need to fix the mapping for the newly created call process manually.
This could fix the mapping itself, or the input and output schemas for the called
subprocess.

Note: The REST Service descriptor supports both internal and external WADL
references. However, we do not support multiple resources pointing to the
same resource path and having the same HTTP method.
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AMBW-
42280

After migration, the Mapper activity is migrated as an empty activity.

AMBW-
41353

After migration, if the variable list XPath expression of an Iterate group is linked to
multiple schemas then the iterator schema is not resolved.

AMBW-
33641

Getting "Coercion error: Can't find substitution for ""." at design time
after migrating a project.

Release 6.7.0

Key Description

AMBW-
41319

After migration, the $error_<activityname> was not migrated and failed to fetch
error details from the Local Transaction group.

AMBW-
41022

After migration, the subprocess containing the padfront() function failed at
runtime.

AMBW-
40178

After migration, multiple errors occurred for DTD to XSD conversion.

AMBW-
40068

After migration, the SOAP Request Reply activity could not migrate successfully.

AMBW-
40067

After migration, transitions to Invoke activities were not present in a process.

AMBW-
38737

After migration, the faultDetails mapping was incorrect.

AMBW-
37700

After migration from the SAP adapter configurations to TIBCO ActiveMatrix
BusinessWorks™ Plug-in for SAP, the mappings were not migrated.

AMBW-
37114

After migration, the pipe character ('|") was converted to the "or" condition which
resulted in incorrect activity output.
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Key Description

AMBW-
31022

The transition condition now has the migration support of adding the XPath 1.0
tag.

Palette
This topic lists the Closed Issues related to Palettes.

Release 6.9.1

Java Palette

Key Summary

AMBW-
47626

Java to XML activity does not return/generate proper schema when Maven
Buildpath is added.

JDBC Palette

Key Summary

AMBW-
48187

Output Schema is not updated dynamically for overriding the SQL Statement
checkbox selected in the Advanced tab of JDBC_Query activity.

AMBW-
48165

A "Commit & Rollback Failed, Transaction Integrity Unknown" error is thrown for
JDBC Stored Procedure Activity.

AMBW-
47943

While clicking the Result Sets Use Schema option on the JDBC_Call_Procedure
activity > Advanced tab, it should generate the output. Instead, it throws the
"DRIVER IS LOCKED FOR USE WITH EMBEDDED APPLICATIONS" error pop-up with
the TIBCO DD driver for MSSQL 2016 Server.

BWCE-
5306

The Custom JDBC Driver AS400 and the SQL Direct activity is not retuning the
connections back to the pool.
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JMS Palette

Key Summary

AMBW-
42975

The installdriver.xml script is unable to install jars required for
jms.ibmmq.runtime.

Parse Palette

Key Summary

AMBW-
47173

The Parse Data activity processes all rows successfully when the first value of the
row is empty and the Continue on error checkbox is not enabled. Use the
property
com.tibco.bw.palette.parse.data.throwExceptionForEmptyFirstColumn=true
for the proper exception of the usecase.

REST and JSON Palette

Key Summary

AMBW-
47850

The InvokeRESTAPI activity concatenated the header values when repeating
headers are sent from a server in response.

XML Palette

Key Summary

AMB
W-
4742
2

Unable to disable XML validation at activity level since Parse XML is not enforcing the
properties in TIBCO ActiveMatrix BusinessWorks™.
Use the following property to disable the XML validation at the activity level for Parse
XML activity,
-
Dbw.application.activity.validateOutput.<appName>.application.<appVersion>.
<packaganame>.<processname>.<activityname>=false

Release 6.9.0
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HTTP Palette

Key Summary

AMBW-
46677

The Send HTTP Request activity fails to send image files in the mimeHeader
because of the missing "filename" parameter in the content-disposition header at
runtime.

AMBW-
46605

The endpoint URL is generated as "HTTPS" instead of "HTTP" when the
Confidentiality field on the HTTP Connector shared resource is configured with
the module property value set to "false".

BWCE-
4842

If a REST service is configured with Blocking Queue Size on service binding, then
after accepting a certain number of requests, the remaining are not rejected. To
achieve the expected behavior, the number of requests to be processed must be
equal to the addition of the Max QTP value on the HTTP Connector shared
resource and BQS value at binding.
For example, if 50 requests are processed at any given time, and the Max QTP is
10, then the Blocking Queue Size on service binding must be set to 40.

For applications with a service using HTTP Palette activities, you need to set the
following property,
-Dbw.engine.http.jetty.blockingQueueSize=<BQS_intger_value> in the VM
arguments.

Note: If the above property is used for REST service, then its value must be the
same as the Blocking Queue Size on service binding.

Java Palette

Key Summary

AMBW-
46550

Java object reference passed from parent process to subprocess fails to work.

AMBW-
44678

The SOAP Invoke MTOM throws a Java heap space out of memory error with large
payloads of 800 MB.
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Java Palette

Key Summary

AMBW-
36726

The output schema for JavaToXML activity is not generated if there is a defined
public method without a defined respective member variable.

AMBW-
33916

The JavaToXML activity fails to generate the schema for classes with no member
variables.

JDBC Palette

Key Summary

AMBW-
46797

JDBC Transaction Group does not end the database session when JDBC Call
Procedure times out.

AMBW-
46201

JDBC Update Activity inserts a "NULL" value instead of an empty string into the
database.

JMS Palette

Key Summary

AMBW-
46727

TIBCO ActiveMatrix BusinessWorks™ application fails with a specific error, "Can
not change client ID" when Client ID is set in EMS Server Level.

Mail Palette

Key Summary

AMBW-
46731

The Send Mail input credentials are not overriding with SMTP shared resource
credentials.
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REST and JSON Palette

Key Summary

AMBW-
46603

When an XML file containing nested double quotes (") is passed as an input to
Render JSON activity with Generic schema type, it does not get escaped in the
output JSON string.

AMBW-
46602

The Render JSON activity is unable to transform "&apos;" from the XML string to
single quote (') in Generic mode.

AMBW-
46580

Runtime throws a "JsonParserException" error on Parse JSON activity with
Generic mode when the content to be parsed is larger than 512 characters.
The character limit is now increased by default to 1024 characters.
To parse a large JSON file (for example, more than 1024 characters), the user has
to pass the below property in the TIBCO Business Studio™ for BusinessWorks™ VM
arguments to increase the default cache size:
com.tibco.plugin.restjson.json.setCacheSize = <Integer value>

XML Palette

Key Summary

AMBW-46044 Recursive extension type in schema gives run-time error.

Release 6.8.1

HTTP Palette

Key Summary

AMBW-
45532

For the applications using the HTTP Client shared resource configured with the
Thread Pool shared resource having Core Pool Size greater than 10,
"IllegalArgumentException" is thrown at runtime.

AMBW-
45450

ActiveMatrix BusinessWorks redirects a SOAP call to the HTTP Receiver activity if
the Enable Access Log property is enabled and an application contains both a
SOAP service and HTTP Receiver activity.
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JDBC Palette

Key Summary

AMBW-
44571

You can see the Updated Parameter->Data type value in the JDBC statement
parameter preparation.

AMBW-
45455

Interpreted the Invalid XML Chars check box, not available in ActiveMatrix
BusinessWorks 6.6.1. You can see an Invalid white space character (0x1c) in the
text to output.

AMBW-
45445

The Number element on the Input tab of JDBC Call Procedure activity shows an
integer value and not a decimal value after loading the procedure or function.

AMBW-
43303

ActiveMatrix BusinessWorks does not retrieve data of type timestamp from a
database.

JMS Palette

Key Summary

AMBW-
45456

If we use a JNDI Destination name for the actual queue in the ActiveMatrix
BusinessWorks project when connecting to the IBM MQ server, it gives
InvalidDestinationException.

AMBW-
45454

Huge memory consumption is causing the AppNode to hang. A new session is
being created on every run causing huge memory consumption. Now, the Ack
Mode in the key is used also while pulling which resolves the huge memory
consumption issue as the session is not created on every run.

AMBW-
45333

The null pointer exceptions are thrown when you destroy the JMS Reply activities
while application instances are being stopped.

AMBW-
44019

The JMS Request Reply activity in ActiveMatrix BusinessWorks 6.x creates a new
Message Producer per request, which causes the disk overhead on the EMS side,
hence leading to performance issues.

AMBW-
43126

When you use an element from some external schema to join the conversation,
the mapping showed an error "No matching namespace prefix".
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JMS Palette

Key Summary

AMBW-
35465

There is no option available for "Supports XA Transactions" in JMS Connection in
ActiveMatrix BusinessWorks 6.x.x.

AMBW-
31953

Get JMS Queue Message activity shows different types of timeout errors for the
same scenario when there is no message in the queue.

Mail Palette

Key Summary

AMBW-
45461

"Test connection" for SMTP resource shows the error "Configuration error in field
[Host] and/or [Port], the value must be a valid hostname and/or port" with
correct values.

Java Palette

Key Summary

AMBW-
44678

The SOAP Invoke MTOM throws a Java heap space out of memory error with large
payloads of 800 MB.

Parse Palette

Key Summary

AMBW-
45862

You cannot rename a file when you use the Parse Data activity to read the file in
batches.

Release 6.8.0
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HTTP Palette

Key Summary

AMBW-
43969

The Send HTTP Request activity fails and throws TimeoutException when the
HTTP Client shared resource is configured with the Jetty HTTP Client library
along with SSL, and the Proxy shared Resource without authentication.

AMBW-
43072

The Send HTTP Request activity fails with 500 error when the HTTP Client
shared resource configured with Apache HTTP Components library and a request
with MIME attachment is sent to REST service.

AMBW-
42083

ActiveMatrix BusinessWorks can not handle non-preemptive basic authentication
when the User-Agent header is not present in the HTTP request.

JDBC Palette

Key Summary

AMBW-
43984

An application goes into the Impaired state when the dbURL has special
characters.

AMBW-
43983

The JDBC Call Procedure activity throws an error and cannot call a stored
procedure when you use PostgreSQL 12 database.

AMBW-
43965

The JDBC Query activity throws the Numeric overflow error when the number
coming from the database is greater than 10 digits.

AMBW-
43964

TIBCO Business Studio for BusinessWorks displays timeout error with SQL stored
procedures when you use Data Direct Driver and XML type parameters as IN or
OUT.

AMBW-
43037

The SQL Direct activity fails for Unicode special characters.

AMBW- TIBCO Business Studio for BusinessWorks now supports overloaded procedures
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JDBC Palette

Key Summary

42443 from PostgreSQL.

AMBW-
42049

The stored procedure input and output parameters with MSSQL DataDirect driver
are inaccessable if the procedure is selected without selecting Schema, and
Catalog or Package.

AMBW-
41912

Heap memory leak is observed on an AppNode for the SQL Direct activity in an
application,

AMBW-
38321

The JDBC Tibco Driver for PostgresSQL is upgraded from 5.1.4.000097 to
5.1.4.000329 and the  Native Driver is updated with 9.4.1212 to 42.2.18.

AMBW-
31970

JDBC Driver for Microsoft SQL server is upgraded from 4.0 to 8.2.2.

JMS Palette

Key Summary

AMBW-
43981

Whenever EMS fault-tolerance server is switched or the EMS server is restarted,
the JMS Send Message activity loses the first message after reconnecting.

AMBW-
42608

Exchange of message takes place for a queue type messaging style configured in
JMS Sender and a topic type messaging style in JMS Receiver.

AMBW-
37702

TIBCO Business Studio for BusinessWorks displays an error when connecting to an
SSL enabled EMS server.
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Mail Palette

Key Summary

AMBW-
43990

An application becomes unresponsive on the Send Mail activity and does not
timeout when the existing engine threads are occupied.

REST and JSON Palette

Key Summary

AMBW-
43585

The Invoke REST API activity is migrated as empty for some activities.

AMBW-
43255

The design time and run time Swagger files are now including the definitions of
the extended elements from different XSD.

XML Palette

Key Summary

AMBW-
44572

Non-default namespace can not map to empty URI Set the -
Dbw.xml.jsonrest.multiple-ns.removensprefix=true property as a VM
argument in TIBCO Business Studio for BusinessWorks.

This property removes all non default prefixes from the XML and uses only default
namespace prefix for all namespaces and ensures that a non default namespace
is never bound to an empty URI.The Render XML activity adds an extra
namespace xmlns=" " at the root level of the schema.

AMBW-
43994

The Value-of max(xsd:int*) expression returned as a scientific notation value when
the Transform XML activity has bigger numbers in input.

AMBW- The Parse XML activity gives error when the input file encoding was UTF-8-BOM
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XML Palette

Key Summary

41240 and the Validate Output check box was selected.

Set the -Dbw.application.activity.validateOutput.treeValidation=true
property as a VM argument when validating an output XML.

AMBW-
33245

An error occurs when the YearMonth datatype is typecasted with the xsd:string
().

Release 6.7.0

FTP Palette

Key Summary

AMBW-
38106

The FTP Rename File activity failed intermittently to rename files from a
particular directory when the FTP Rename File activity was a part of a
subprocess, which was called from a Call Process activity with the Spawn check
box selected.

HTTP Palette

Key Summary

AMBW-
41408

The Send HTTP Request activity threw the HttpClientException when the
application deployed on TEA was restarted, and the HTTP Client shared resource
had the Apache HttpComponents(Supported by HTTP 1, SOAP and REST)
implementation library, and the Provide Client Resource check box was selected
on the Advanced tab of the Send HTTP Request activity.

AMBW-
41006

The SSL was configured even when the SSL Client shared resource picker was not
empty and the module property against the Confidentiality field at HTTP Client
shared resource was set to false.
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HTTP Palette

Key Summary

Set the bw.plugin.http.client.relyOnConfidentialityField property to true.

AMBW-
40484

The Send HTTP Request activity could not send the request with Content-type as
multipart/form-data to ServiceNow with Apache HttpComponents library.

Send the request using the Jetty HTTP Client library in the HTTP Client shared
resource.

JDBC Palette

Key Summary

AMBW-
42049

The stored procedure input and output parameters with MSSQL DataDirect driver
were inaccessable if the procedure was selected without selecting Schema, and
Catalog or Package.

AMBW-
41608

The JDBC connection created against the database increased beyond the
configured value when any of the following cases occurred:

l There was a network issue.

l Database was stopped or started

l The bw.engine.activity.async.waitTime property was present in the
config.ini file.

AMBW-
41215

The Null Pointer Exception was thrown when re-connecting the database with an
application.

AMBW-
41146

The input and output parameters for a stored procedure were not accessible
when the stored procedure was inside a package.

AMBW-
41145

The JDBC Call Procedure activity failed and generated the Unknown exception
occurred.

AMBW- TIBCO ActiveMatrix BusinessWorks™ generated the java.sql.SQLException at
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JDBC Palette

Key Summary

40335 runtime when the Database URL had forward slashes in the sslTrustStoreLocation
path.

JMS Palette

Key Summary

AMBW-
41548

For the ActiveMQ JMS provider, the JMS Receive Message activity failed to
reconnect for network issues.

AMBW-
40637

The JMS Send Message activity displayed the Null pointer exception
intermittently when messages were sent in concurrent batches.

AMBW-
35597

The JMS Request Reply activity can now filter requests and response messages
correctly on the basis of JMS CorrelationID or MessageID.

AMBW-
34959

Messages were stuck in an EMS queue when the EMS connection dropped and
reconnected.

This issue occurred intermittently when the AppSpace was configured with
FTgroup persistence with the EMS FT URL.

Also, the secondary EMS server was not available intermittently after the failure of
the first server.

AMBW-
33187

In TIBCO Business Studio™ for BusinessWorks™, the default value for the
Directory preference option on the BusinessWorks > Palettes > JMS preference
page was invalid.
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Mail Palette

Key Summary

AMBW-
39777

The Receive Mail activity used to start the handshake with TLSv1 irrespective of
the TLS SSL Protocol selected in the SSL Client Configuration for the SMTP
shared resource.

AMBW-
39776

The Send Mail activity used to start the handshake with TLSv1 irrespective of the
TLS SSL Protocol selected in the SSL Client Configuration for the SMTP shared
resource.

REST and JSON Palette

Key Summary

AMBW-
41167

For some scenarios, the Parse JSON activity generated the XMLStreamException
in the console, in logs and the Output tab in Job Data view became empty when
an application was executed in the debug configuration.

Set the bw.engine.debug.core.disableNamespaceFixup property to true.

Do not use this property while mocking the output for unit testing.

AMBW-
40875

The Parse JSON activity could not parse a JSON key having a value of array type
with length more than 512 characters.

AMBW-
40618

Logs for the Invoke REST API activity now also display the response body
information. Set the following logger in the logback.xml file:

<logger name="com.tibco.bw.palette.restjson.runtime.RestInvoke">
<level value="DEBUG"/>
</logger>
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XML Palette

Key Summary

AMBW-
41240

The Parse XML activity threw Content is not allowed in prolog error when the
input file encoding was UTF-8-BOM and the Validate Output check box was
selected.

Set the -Dbw.application.activity.validateOutput.treeValidation=true
property as a VM argument when validating an output XML.

AMBW-
33245

An error occurred when the YearMonth datatype was typecasted with the
xsd:string().

Policies
This topic lists the Closed Issues related to Policies.

Release 6.9.1

Key Description

AMBW-
33546

For a better user experience, a tool hashpassword.jar has been provided for
generating obfuscated passwords with basic XML Authentication.

Release 6.9.0

Key Description

AMBW-
46589

The basic security profile compliance is not disabled for a SOAP service even
when the -Dbw.governance.bspCompliant.disabled=true property is set at an
AppNode level.

Release 6.6.1
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Key Description

AMBW-
39090

A SAML message was not forwarded and generated the following error:

Error unmarshalling a SAML assertion.

AMBW-
38857

The Heap Out of Memory message was thrown for faulted jobs while using the
SOAP/HTTP Invoke activity with Policy Basic Authentication.

AMBW-
37873

The performance was degraded when the authentication was done with LDAP.
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Known Issues
The following known issues have been identified in this release of TIBCO ActiveMatrix
BusinessWorks™.

The known issues are grouped by components:

l Administration

l Binding

l General

l Migration

l Palette

l Policy

Administration
This topic lists the Known Issues related to Administration.

Key Description

BWCE-
5592

Summary: Unable to add Activity execution stats on PCF environment.

Workaround: None

AMBW-
47153

Summary: Monitoring-related error occurs in bwagent console\logs after
enabling process monitoring and running the agent in DEBUG Mode.

Workaround: None

AMBW-
46059

Summary: The application properties are not displayed in the Internet Explorer
browser.

Workaround: Use any other web browser such as Google Chrome, Firefox, or
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Key Description

Microsoft Edge.

AMBW-
44868

Summary: The bwadmin --help command still shows help for the upgrade
command that is not supported in this release.

Workaround: None

AMBW-
44826

Summary: When OpenTelemetry is enabled or disabled via Admin UI or Admin
CLI, in pertaining debug level log, EnableOpenTracingCommand or
DisableOpenTracingCommand is displayed respectively.

Workaround: None

AMBW-
41955

Summary: If an AppNode log is not present and you click the Download Log
button from Admin UI, an exception is thrown.

Workaround: Start an AppNode and try again

AMBW-
41795

Summary: When agent is started with MySQL 8.x jar, a harmless message about
the driver being deprecated is displayed on bwagent and the bwadmin console.

Workaround: None

AMBW-
41794

Summary: A harmless warning is shown when starting a BWAgent.

Workaround: None

AMBW-
41555

Summary: The Appnodeconfig button is not available under the Appnode Data
view.

Workaround: Navigate to any other page within an AppNode and then navigate
to appnode config.

AMBW-
37468

Summary: Harmless logs are shown at Admin Console on SUSE 12 Linux.

Workaround: None

AMBW-
32929

Summary: Process monitoring statistics are not populated if checkpoint has been
used in the process.

Workaround: None
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Key Description

AMBW-
32922

Summary: On Process Monitoring page, Job filter displays results for records on
the current page only.

Workaround: None

AMBW-
32904

Summary: Sometimes all the transitions are not highlighted and input/output
data is not seen for activities when process monitoring is enabled using UDP
transport.

Workaround: Use FTL transport for process monitoring.

AMBW-
32594

Summary: On the Process Monitoring page, the Datetime value in the
MM/DD/YYYY format for filtering jobs does not work.

Workaround: Use the datetime value as displayed in the database

AMBW-
32071

Summary: Failed to Upload Large EAR file larger than 10MB with MariaDB.

Workaround: Use any other database.

AMBW-
32057

Summary: Agent Count is getting increased for AppSpace after restoring Domain.

Workaround: None

AMBW-
31832

Summary: In the process diagram view of Process Monitoring, if a constructor
block includes a catch block, then it is not highlighted after its execution.

Workaround: None

AMBW-
31831

Summary: In Process Monitoring, sometimes, because of uid issue references are
not highlighted and input or output data might not displayed.

Workaround: Remove all uid related warnings from TIBCO Business Studio™ for
BusinessWorks™. Create an EAR file. Deploy the EAR file, and then enable process
monitoring.

AMBW-
31600

Summary: When an application is running and AppNode is restarted, the job id is
duplicated and two jobs with same id is present under process monitoring.

Workaround: None
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Key Description

AMBW-
31493

Summary: User is getting considered as Role in file based authorization.

Workaround: None

AMBW-
30759

Summary: Failed to get AppNode Config.ini file's property details by REST API.

Workaround: None

AMBW-
30398

Summary: Unable to register BWAgent from the command line on some
machines.

Workaround: None

AMBW-
29846

Summary: Process diagrams are not visible on the Admin UI when the project
name has a period (.) between the numbers.

Workaround: Remove the number from the process package name, regenerate
the EAR file, and re-deploy it.

AMBW-
29725

Summary: The Internal Server Error is displayed intermittently in logs when there
is a change in the network.

Workaround: None

AMBW-
29632

Summary: Process diagram is not shown in TIBCO® Enterprise Administrator
when the TIBCO ActiveMatrix BusinessWorks™ process package name contains
number.

For example com.tibco.bw.service.SIXXXZZZ.1.0

Workaround: None

AMBW-
29235

Summary: When application components are started or stopped multiple times
from the Admin UI, the TIBCO-BW-TEAAGENT-500506: Failed to get components
for Application error is sometimes displayed.

Workaround: Refresh the entire page or navigate to different tab, for example,
the AppNodes or AppSpaces page and then go back to the Components tab.

AMBW-
28244

Summary: Admin UI shows wrong information under Installation tab after
upgrade.
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Key Description

Workaround: None.

AMBW-
27654

Summary: Identity-Truststore is not created for the SSL Client post migration.

Workaround: After migrating the SSL enabled service , it will create the SSL client
resource. In SSL client resource, provide the keystore provider resource in
Keystore Provider as Trust Store. Provide the Keystore only. This will import all
the certificates required for SSL enabled services in ActiveMatrix BusinessWorks™
6x.

AMBW-
26286

Summary: Unable to upload large sized EAR files (~10 MB) when the DB2
database is used for the DBEMS or DBFTL mode.

Workaround: None

AMBW-
25889

Summary: From the command line, users can enable the OSGi and create a new
AppNode on the same OSGi port.

Workaround: Use the Admin UI to enable the OSGi port.

Binding
This topic lists the Known Issues related to Binding.

Key Description

AMBW-
46861

Summary: When invoking a REST service created with a Swagger file having an
"array" tag under the Components/Schemas section, the "array" tag is not
reflected in the runtime Swagger file.

Workaround: Add the "array" tag in the generated runtime Swagger file manually
if you need to create a REST service/reference binding.

AMBW-
46806

Summary: Accept header value for Fault response is not honored in Swagger UI
when the OAS 3.0 REST service configured with multiple response formats is hit.

Workaround: Use Postman Client to hit the service and pass the Accept Header
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Key Description

according to the expected response content-type.

AMBW-
46721

Summary: When creating a top-down REST service with an OAS 3.0 JSON file
having response header parameters and multiple response formats, the
parameters are not reflected in the service binding.

Workaround: None

AMBW-
46663

Summary: If an OAS 3.0 REST service is created using a JSON file having
anyOf/oneOf keywords with one of the schema referred with "$ref" and another
sub-schema as "inline", then the inline schema is not reflected in the Reply
activity.

Workaround: None

AMBW-
46607

Summary: If an OAS 3.0 REST service is created using a Swagger file having inline
schema with "oneOf/anyOf" or nesting with "allOf", then the schema elements are
not resolved in the Input tab of the Reply activity.

Workaround: None

AMBW-
46002

Summary: The "allOf" tag is not reflected in the runtime Swagger JSON
generated for the REST service created using an imported Swagger JSON having
the "allOf" tag.

Note: The schemas are merged into a single schema object in the runtime
Swagger file and this doesn't impact the functionality.

Workaround: None.

AMBW-
45941

Summary: The Swagger specifications having the pattern keyword are not
supported in ActiveMatrix BusinessWorks 6.x.

Workaround: You can either manually modify the Swagger specifications to
remove the pattern tag before importing it in TIBCO Business Studio for
BusinessWorks, or else after creating the service, you can manually modify the
XSD by removing the pattern restriction for the respective element definition.

AMBW- Summary: The description provided for form parameters on REST 3.0 service
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Key Description

44739 binding is not reflected on the reference binding as well as on top-down service
binding's Form Parameters table.

Workaround: None

AMBW-
44492

Summary: The 415: Unsupported Media Type error is thrown on Invoke
activity of a REST Reference Binding while invoking a REST service with Request
and Response formats other than JSON. That is, XML or Text.

Workaround : To get rid of the error, select JSON format in Request and
Response along-with other formats.

AMBW-
44479

Summary: The dynamicConfigurations WSDL part and dynamicConfigurations
element aren't automapped by default for the input of Invoke activity created
from the reference binding.

Workaround: Either map manually or map using the Show Check and Repair
option.

AMBW-
44338

Summary: On selecting Binary checkbox in Response tab of REST Service Binding,
if we keep default configurations in Resource Schema then the Reply activity's
response is seen as "String" instead of base64Binary.

Workaround: On selecting Binary checkbox re-select "binary" or "base64" from
Resource Schema dropdown.

AMBW-
44208

Summary: The java.lang.NullPointerException is thrown on adding new
operation to a REST service when you change the JSON Definition Style or the
Request schema from the drop-down for the newly added operation.

Workaround: If you are adding new operation then select the required schemas
in the REST Service Wizard and avoid modifying it from service binding.

AMBW-
44197

Summary: REST Service Binding configuration error is thrown at design
time when the Resource Schema of DELETE operation is modified in the
Response tab of REST Service Binding.

Workaround: If you want the DELETE operation response to be other than String
then select the appropriate value in the drop-down menu for Response while
creating a service using REST Service Wizard.
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Key Description

This workaround is not applicable for the Binary Response format.

AMBW-
44116

Summary: For REST 3.0 service if you select Binary check box in Response, then
at design time the Resource Schema details "$item base64Binary" is not
displayed on Response tab for all operations on service binding and for POST
operation on reference binding. There is no impact on anything at runtime.

Workaround: None.

AMBW-
44022

Summary: The Swagger UI accessed using Lrestdoc command is not supported
to show the callbacks section for the REST Operation of an ActiveMatrix
BusinessWorks REST Service Endpoint created by dragging a Swagger Path whose
operation is configured with callbacks.

Workaround: None.

AMBW-
43156

Summary: The Swagger UI is seen as blank when the Swagger URL is hit from
Internal Web Browser in TIBCO Business Studio for BusinessWorks.

Workaround: Hit the Swagger URL from an external browser.

AMBW-
43023

Summary: The "format" tag is not created for "Password" type form parameter in
bottom-up REST service and hence seen as String on the reference binding.

Workaround: Manually add the "format" : "password" tag to the form parameter
in the swagger file.

AMBW-
36113

Summary: A multipart message where one part points to type and the other part
points to element and a message using mixed security mode is not supported.

Workaround: Change mixed security mode in a given WSDL.

AMBW-
32951

Summary: A SOAP service responding with mustUnderstand attribute as true is
ignored irrespective of selecting or deselecting the Ignore mustUnderstand
check box on the SOAP Reference binding. This behavior does not affect the client
and server communication.

Workaround: None

AMBW- Summary: On creating SOAP Reference Binding with the concrete WSDL
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Key Description

32760 generated at run time with multilevel schema imports, the
java.lang.NullPointerException is displayed when clicking the reference binding.

Workaround: None

AMBW-
29098

Summary: When creating a concrete WSDL by right-clicking on the Service
Descriptor folder, the following error is generated at design time: WSDL import
error.

Workaround: None

AMBW-
27870

Summary: On importing WSDL with RPC Encoded style, a validation error is
generated at design time since the underlying schema with namespace
http://schemas.xmlsoap.org/soap/encoding/ is not generated.

Workaround: To remove the validation error and create the SOAP Reference
Binding, download the encoding schema with the said namespace and ensure
that schema is a part of the application module or the shared module.

AMBW-
27435

Summary: When module properties used from a shared module project were
renamed, the changes made were not reflected at the SOAP binding level.

Workaround: Select the updated module property from the drop down in the
SOAP binding.

AMBW-
26806

Summary: When a REST service with a schema that uses a type which was
imported from another XSD is invoked in a REST Reference Binding, it fails with
the ServiceRuntimeException.

Workaround: None

AMBW-
23104

Summary: When the WSDL uses multiple parts in the Request body of an
operation, a design time validation error occurs on the generated SOAP reference
binding. The application works fine at run time.

Workaround: None

AMBW-
13607

Summary: REST Doc UI is not supported on Firefox browser.

Workaround: Use other browsers for the Doc UI.
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Key Description

AMBW-
13572

Summary: For some use cases, REST Doc UI does not show the correct error code
in case of Internal Server errors on the Server side.

Workaround: Check the raw message that contains the correct error code.

AMBW-
13485

Summary: REST Doc UI does not support browsers like Internet Explorer.

Workaround: Use Chrome browsers for the Doc UI.

AMBW-
8982

Summary: Changing the Resource name in the REST service Bindings tab, does
not update the Resource Service Path.

Workaround: None

General
This topic lists the Known Issues related to General issues.

Key Description

AMBW-
48340

Summary: The application configured with the property,
bw.independent.component.startup=true goes into a stopping state when any of
the shared resources are not available.

Workaround: Fix the connection of SR and start the failed component using TEA or
Admin CLI.

AMBW-
48217

Summary: When the shared resource takes time to connect to the Database or
Server, intermittently an error "Init module failed for module" is thrown at runtime
even though the values provided in the shared resource are correct.

Workaround: Introduce a sleep or re-run the application manually using startcomp
OSGI commands.

AMBW-
47025

Summary: After creating the Maven test file, if the user renames the TIBCO
ActiveMatrix BusinessWorks™ Process name, the change is not reflected. The user
cannot test run the same.



TIBCO ActiveMatrix BusinessWorks™ Release Notes

90 | Known Issues

Key Description

Workaround: Re-create the test file after renaming the process.

AMBW-
46231

Summary: When two properties from two different modules having a common
name are promoted, only one property gets promoted and seen under the
application.

Workaround: Keep each property name unique before promoting in a batch.

BWCE-
5076

Summary: For RHEL 9.x, the check box selection for any BusinessWorks activity is
not visible.

Workaround: None

AMBW-
46056

Summary: The OSGi commands to start and stop the application do not work.

Workaround: Use TEA, Admin CLI, or REST API to start and stop the application.

AMBW-
45408

Summary: The Ant task failure error occurs when you uninstall ActiveMatrix
BusinessWorks 6.8.0 hotfixes, 6.8.0, and 6.7.0 from the TIBCO_HOME containing the
version 6.7.0.

Workaround: Ignore the errors and proceed further with uninstallation.

AMBW-
45183

Summary: A non-readable POM file error is thrown upon importing CXF project
from Maven repository.

Workaround: None. It does not affect the functionality.

AMBW-
45146

Summary: The FluentD container fails to insert the activity (input/output) data if
the data size is greater than 4000 characters for the Oracle database.

Workaround: Set the MAX_STRING_SIZE = EXTENDED for the Oracle database,
which increases the byte size capacity from 4000(default) to 32767. Note that this
change is at the server level and is irreversible.

AMBW-
45015

Summary: An activity having a large input data is not shown in the job details on
the Execution History tab for MySQL.

Workaround: None
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AMBW-
44769

Summary: On some Linux machines, you cannot launch TIBCO Business Studio for
BusinessWorks.

Workaround: You must ensure that you have GTK 3.2 installed on your machine
and then re-launch TIBCO Business Studio for BusinessWorks.

AMBW-
44643

Summary: The Transform XML activity's output is not visible in Job Data
debugger output tab.

Workaround: This issue occurs only on Windows operating system. So a mouse
click and mouse hover on the Job Data section during debugging the application
on the Transform XML activity displays the output.

AMBW-
44437

Summary: Two .application folders are created when a new application is
created in a new workspace.

Workaround: On launching TIBCO Business Studio for BusinessWorks wait for 5-10
seconds to ensure that it loads completely and then create a new application. If
there are two .application folders created after loading TIBCO Business Studio
for BusinessWorks then restart it.

AMBW-
43862

Summary: EMF Validation does not work for imported existing projects by using
Module Property to Keystore URL.

Workaround: Reassigning the same module property resolves the validation error.

AMBW-
43860

Summary: Consuming a TIBCO Flogo service with parameters having Object data
type in Input and Output schema from ActiveMatrix BusinessWorks client is not
supported.

Workaround: None

AMBW-
43779

Summary: Unit testing does not start when a connection is not successful for the
HTTP Receiver being mocked.

Workaround: None

AMBW-
43743

Summary: Unit testing framework does not support Java palette activities.

Workaround: None.
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AMBW-
43118

Summary: For Open API Specification 3.0 service, the array of Form Parameters is
sent as comma-separated values from Swagger UI which causes the request to fail
with the 500 internal server error in TCI.

Workaround: Use Runtime swagger file to create the service.

AMBW-
42385

Summary: You can't launch TIBCO Business Studio for BusinessWorks after adding
it into Dock in MAC OS.

Workaround: None.

AMBW-
42174

Summary: Customization of template for an unencrypted project template fails.

Workaround: Import the template directly in TIBCO Business Studio for
BusinessWorks and rename it as per your requirement.

AMBW-
42046

Summary: Encryption Setting Window shows no editable fields when opened by
clicking on the Lock Icon if TIBCO Business Studio™ for BusinessWorks™ is not in
full-screen mode.

Workaround: Open Encryption Settings when TIBCO Business Studio for
BusinessWorks is in full-screen mode or enter into full-screen mode for Encryption
setting if it is opened in a minimized view.

AMBW-
41991

Summary: Eclipse command line options such as -clean does not work with
TIBCO_
HOME/studio/4.0/eclipse/TIBCOBusinessStudio.app/Contents/MacOS/TIBCOBusines
sStudio executable on macOS platform.

Workaround: Use the following command:

TIBCO_
HOME/studio/4.0/eclipse/Eclipse.app/Contents/MacOS/TIBCOBusinessStudi
o --launcher.ini TIBCO_
HOME/studio/4.0/eclipse/TIBCOBusinessStudio.ini -clean or any other
eclipse command line option

AMBW-
41950

Summary: In bwdesign, if we export substvar files with the same name twice in
the same location, it does not overwrite the substvar file.

Workaround: Delete the previous substvar file and export substvar again.
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AMBW-
41948

Summary: Many to one mapping is not supported for Smart Mapper.

Workaround: None

AMBW-
41846

Summary: Any operation on the module or application properties that leads to a
change in their order results in a faulty difference generation. So, such operations
are not supported in TIBCO ActiveMatrix BusinessWorks™ 6.7.0.

Workaround: None.

AMBW-
41832

Summary: The lock icon on the encrypted profile in the difference viewer
perspective is shown based on whether the workspace copy of the profile is
encrypted or not. Currently, if the workspace copy of the profile is encrypted, then
in the difference viewer perspective, the lock icon is shown even on the un-
encrypted revisions of that profile.

Workaround: None.

AMBW-
41827

Summary: The properties and profile are not showing in the application property
editor on opening the editor for the first time in a new workspace.

Workaround: Close and reopen the editor, it shows all the details.

AMBW-
41779

Summary: If a keystore file location or name is changed then on refresh blank
property value is shown and on running the application, the File Not Found
Exception is thrown.

Workaround: Restore file with a valid name at a specified location on disk and do
project clean.

AMBW-
41716

Summary: Any changes in the module or application properties inside groups are
not supported in ActiveMatrix BusinessWorks 6.7.0 and the corresponding
difference generation is faulty in such cases.

Workaround: None.

AMBW-
41715

Summary: The difference viewer calculates the difference and highlights the
properties, but does not highlight any corresponding fields of the properties.

Workaround: Switch to the text difference mode and see the difference in the non-
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UI fields.

AMBW-
41499

Summary: In the substitution variables file, only five types of module properties
are saved: String, Integer, Long, Boolean, and Password.

When a module property is assigned a type other than the above-mentioned types
then that type is saved as a String in the substvar file in the Diff Viewer window.

Workaround: None.

AMBW-
41474

Summary: If there are any changes in the Description field of a module or
application property, it is not highlighted in the difference viewer.

Workaround: None.

AMBW-
41417

Summary: Multiple coercion does not work upon trying to toggle the faulty
process.

Workaround: The QName conflict here refers to having two schemas defining two
elements with exact same name and same namespace, but the element contents
differ. This causes design-time problems without warning when you use both
elements in the same process.

AMBW-
41307

Summary: Application property editor does not display value in case of removing
encryption setting using the Clear All button and exporting profile.

Workaround: Close the application properties editor and open it again.

AMBW-
41277

Summary: When you try to install a missing plugin using the Quick Fix option and
you select or unselect a plugin version from the list of provided versions; the
following message is displayed: Cannot complete the install because of a
conflicting dependency.

However, you can still install the plugin successfully.

Workaround: None.

AMBW-
41271

Summary: The application property editor doesn't get refreshed intermediately on
encrypting profiles.

Workaround: None.
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AMBW-
41252

Summary: The New Name field in the Rename Projects section on the Create
Project From Template window is not enabled on a single click.

Workaround: First click on the old name of the module or the application after
which the field is enabled. .

AMBW-
41155

Summary: The Password field is shown as changed while doing a Shared Resource
diff, even if the password are the same.

Workaround: None.

AMBW-
41238

Summary: Confirmation message is displayed with any operation on encrypted
profiles.

Workaround: Click Yes.

AMBW-
41035

Summary: The Authentication field is shown while doing a diff when the
Confidentiality field is set for HTTP Connector shared resource.

Workaround: None.

AMBW-
40811

Summary: Default icon shown instead of Custom icon for the Call Process and
Java Invoke activities within external shared module.

Workaround: Manually browse the Custom icon field value and add respective icon
to activity on importing external shared module.

AMBW-
40464

Summary:ActiveMatrix BusinessWorks applications fail at run time in TIBCO Cloud
Integration if they consume a Flogo endpoint that has Post/Put Operations.

Workaround: None.

AMBW-
40010

Summary:null pointer exception is thrown at run time on ActiveMatrix
BusinessWorks Mesh client when the organization name contains a space
character.

Workaround: When importing the ASR descriptor json file to create a Mesh client,
there is a second wizard page for customizing json file location (Change swagger
name). In that wizard page, remove the space from the folder name.
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AMBW-
39899

Summary: The null pointer exception reported on clicking Binding Section in
Components after the Refactoring operation.

Workaround: Post refactoring, close the Module Descriptor section and reopen it.
No popup is displayed.

AMBW-
39887

Summary:ActiveMatrix BusinessWorks Mesh Client applications fail at runtime in
TIBCO Cloud Integration if they consume a Flogo Mesh Service that has Post or Put
Operations.

Workaround: None.

AMBW-
39837

Summary: The collectappnodedata command is not working on the AIX platform.

Workaround: None.

AMBW-
39804

Summary: SVN compare with revision option doesn't work for any revision other
than the base revision.

Workaround: None.

AMBW-
38593

Summary: Condition fails to evaluate completely when you try to equate a
boolean value to a string.

For example:-If an expression is $DataGen/group/bool2 != "false"', where the
bool2 is true()

Workaround: Simply update "false" to false() or 0 and run the project. It runs as
expected (or vice-versa if its equated to "true" value)

AMBW-
38580

Summary:Transition configuration error for specific customer projects.

Workaround: When a project has the Invalid expression value: [: not a Boolean]
error, complete the transition by equating it to either "true" ("1") or "false" ("0")
and run the project.

AMBW-
37714

Summary:Local Transaction group option is not present in the drop-down list
present for the Group Type field for a group.

Workaround: User should ungroup the existing group and create a new group.
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AMBW-
37594

Summary: Breakpoints are not working when execution flow goes from one
process to another.

Workaround: Select an activity where debugging with the breakpoint is halted. It
enables the Resume button. Click the button to resume debugging.

AMBW-
36990

Summary: When you delete a module shared variables or job shared variables
from the Unused Resources view, then the editor for module shared variables or
job shared variables does not get refreshed automatically.

Workaround: Close the module shared variables or job shared variables editor and
open it again.

AMBW-
34416

Summary: Failed to connect to AppNode using SSH client

Workaround: Use HTTP client. Preferred way is using curl.

AMBW-
34404

Summary: Incorrect trace is generated for the invoke process with default jaeger
properties.

Workaround: Set JAEGER_SAMPLER_TYPE=const, and JAEGER_SAMPLER_PARAM=1
properties in the AppNode or AppSpace config.ini file.

AMBW-
34396

Summary: Clicking Help Contents shows HTTP ERROR: 500 error.

Workaround: None

AMBW-
34343

Summary: An application fails to start in TIBCO Business Studio™ for
BusinessWorks™ when you install the latest EMS driver.

Workaround: Restart TIBCO Business Studio for BusinessWorks.

AMBW-
32761

Summary: The user will not be able to create the references for the custom
operations such as Merge, Update, Trace using the drag and drop swagger file
approach.

Workaround: Users can create the references for the custom operations using the
REST Reference wizard.

AMBW- Summary: Ungrouping nested groups created inside a Catch block of a group may
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28941 not ungroup as expected.

Workaround: None

AMBW-
28663

Summary: The
tibco.bw.sample.policy.samlcredentialmapping.SoapHttpBinding sample fails
intermittently with the error: com.tibco.governance.agent.action.ActionException.

Workaround: None

AMBW-
28378

Summary: When a process property is renamed , the change is not reflected in the
activity and an error is displayed.

Workaround: None

AMBW-
28319

Summary: WSDL interface fails to resolve correctly if multiple WSDLs share the
same target namespace and the SOAP invoke is created with an external binding
reference.

Workaround: Instead of an external reference binding, use binding reference.

AMBW-
28264

Summary: When groups with the On Catch, Catch All and the OnEvent faults are
created inside a constructor or a proxy operation, the activities inside them are lost
after ungrouping.

Workaround: None

AMBW-
27253

Summary: The Identity Provider field in the WSS Consumer policy resource does
not support module properties.

Workaround: None

AMBW-
25219

Summary: Multiple End activities use the same variable in TIBCO ActiveMatrix
BusinessWorks™.

Workaround: None

AMBW-
25073

Summary: The option to test connections, for example JMS or sFTP, in a shared
resource that has a profile is not supported in TIBCO Business Studio for
BusinessWorks.
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Workaround: Specify the server configuration details as literal value or module
properties.

AMBW-
24508

Summary:TIBCO-THOR-FRWK-CMN-500001:Error while renaming bundle file to final
location: - error could be displayed due to low disk space.

Workaround: None

AMBW-
19746

Summary: When you initialize the module shared variable of XSD type with the
select value option to point the XML instance, application fails to start at run time.

Workaround: Enforce the default encoding of AppNode JVM to UTF-8 by adding -
Dfile.encoding=UTF-8 in the bwappnode.tra file.

AMBW-
19540

Summary: When a project contain abstract and concrete WSDL using same target
namespace, a validation error is generated.

Workaround: None

AMBW-
18459

Summary: The ability to reference from a standalone (external) schema to an
inline schema is not supported. If your project contains such a reference, a
validation error is generated.

Workaround: Externalize the WSDL-inline schema and change the import
statements to reference the newly created (external) schema.

AMBW-
17562

Summary: The OSGi configuration properties have been aligned between the
debug environment launched from within TIBCO Business Studio for
BusinessWorks and the AppNode that is launched in an installation. However, a
difference in behavior of the osgi.compatibility.bootdelegation property in
both the environments has been observed.

Workaround: None

AMBW-
16256

Summary: The first attempt to change the data type of an Operator's input or
output schema element fails and the change is not committed. Subsequent
attempts complete without any failure.

Workaround: To commit the change, you must press the return key after every
change.
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AMBW-
14861

Summary: Unable to enter an XPath expression on a transition using the XPath
Builder. This issue is observed on Mac OS only.

Workaround: Enter the XPath expression directly in the Properties tab >
Expression field for the transition without using the XPath Builder.

AMBW-
12490

Summary: Under certain circumstances, substitution types do not resolve properly
in the mapper. The mapper shows errors for them.

Workaround: Try closing and reopening the project. If that does not solve the
issue, try closing and reopening Eclipse. If the errors still persist, perform a project
clean (that is, go to the Project menu and click Clean...).

AMBW-
11534

Summary:TIBCO Business Studio for BusinessWorks crashes occasionally on
Windows 2012 R2 platform when switching workspace from File > Switch
Workspace.

Workaround: Retry by switching the workspace.

Migration
This topic lists the Known Issues related to Migration.

Key Description

AMBW-
40387

Summary: After migration, a path is not executed that leads to the difference in
output.

Workaround: In TIBCO ActiveMatrix BusinessWorks™ 5.x the transition condition
$Map-Data/ConditionType[last()] is treated as boolean but not in ActiveMatrix
BusinessWorks™ 6.x as ActiveMatrix BusinessWorks™ 6.x has strict validations.

In order to resolve this, please update the condition as follows:

count($Map-Data/ConditionType[last()])>0

AMBW-
40187

Summary: Migration of custom icon for the Call Process activity is not supported
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Workaround: After migration, manually browse the custom icon field value for
the Call Process activity.

AMBW-
39231

Summary: While migrating a project using XPATH language for transitions option,
which is set to XPATH 1.0 by default, on the Migration Wizard, the Process inline
namespace schema collision issue occurs intermittently after migration is
complete.

Workaround: Navigate to the faulted process and add the missing schema
location field next to the namespace.

AMBW-
39230

Summary: While migrating a project using the XPATH language for transitions
option, which is set to XPATH 1.0 by default, the service agent process migrates
as an empty process thereby throwing the Argument Cannot Be Null exception
upon trying to view that process post Migration.

Workaround: Migrate that project in a different workspace, because the issue is
intermittent.

AMBW-
36094

Summary: Post migration, a schema cannot refer the .WSDL file in it and if you try
to run the project, the Schema not found error is displayed at the run time.

Workaround: Copy the inline schema that gets created post migration of the
project and paste it into the .WSDL file.

Remove the inline schema dependency from the dependencies section and in the
input editor of the inline schema activity, re-map the point to the inline element.
After this remove the inline schema that is empty and execute the project.

AMBW-
36077

Summary: After migration, if the migrated project contains any SOAP service or
client binding that uses SOAP RPC Encoded arrays, the following WSDL validation
error occurs:

WSDL In-line schema SOAP encoded array type error. In-line schema in WSDL file
contains SOAP encoded array type which requires a fix pattern.

Workaround: Download the SOAP Encoding schema from
'http://schemas.xmlsoap.org/soap/encoding/', and put it into the ActiveMatrix
BusinessWorks project.
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AMBW-
35926

Summary: The migration tool does not support external schema for multi-part
message in the bindings.

Workaround: Create wrapper schemas for all multi-part messages of WSDL.

AMBW-
35899

Summary: Currently, only copy-of mapping is supported for context mapping of
headers.

Workaround: You can either create One-to-one mapping manually or use a copy-
of option for context mappings.

AMBW-
33749

Summary: After migration, additional round brackets in the names of the folder
for externalized schema creates issues at run time.

Workaround: Remove the special characters after migration in the folder names.

AMBW-
30656

Summary: A schema cannot contain two global components with the same
name.

Workaround: Modify one of the schema namespaces or element names, so that
the names are unique.

AMBW-
30476

Summary: After migration, the input mapping for the End activity which refers to
a multi-part WSDL message displays validation errors.

Workaround: A WSDL message is not supported by a mapper. Create a new .xsd
schema element with the structure similar to associated WSDL message, and then
map the schema element in place of WSDL message.

AMBW-
26746

Summary: The TransformXML activity from ActiveMatrix BusinessWorks 5.x did
not migrate correctly if the Input/Output style of the activity was set to TREE in
the ActiveMatrix BusinessWorks 5.x project.

Workaround: None

AMBW-
14547

Summary: When you migrate an TIBCO ActiveMatrix BusinessWorks 5.x project
containing in-built functions in the JDBC Query activity, an Invalid Column name
error is thrown in the JDBC Query activity.

Workaround: Use an Alias instead of the in-built functions in the ActiveMatrix
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BusinessWorks 5.x project.

AMBW-
14295

Summary: After migration, the output of project with REST and JSON palette
activities does not match with the input of the other activities in the migrated
project.

Workaround: None

AMBW-
13683

Summary: Shared resource module property references in the migrated TIBCO
ActiveMatrix BusinessWorks 5.x projects do not show up correctly on non-
Windows platforms.

Workaround: Close and reopen the project.

AMBW-
9969

Summary:ActiveMatrix BusinessWorks 5.x projects with SOAP headers
configuration in SOAP activities are not properly migrated to ActiveMatrix
BusinessWorks.

Workaround: SOAP functionality in ActiveMatrix BusinessWorks is achieved
through SOAP Binding where its detail configuration is outside of ActiveMatrix
BusinessWorks Process. The SOAP headers definition are defined at the Binding
configuration and configured as generic context parameters for the Process. In
the Process, you can use the Get Context activity (from Basic Palette) to retrieve
and process the headers as context data. You can do this manually to complete
the migrated project.

Palette
This topic lists the Known Issues related to Palettes.

Palette HTTP

Key Description

AMBW-
48345

Summary: If multiple applications are deployed on TEA in a single appnode, the
Smart Engine report for "Acceptor Thread Trigger" is not generated for all the
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applications. It gets generated only for the application which is invoked first.

Workaround: None

AMBW-
46027

Summary: ActiveMatrix BusinessWorks does not throw an exception for the
invalid HTTP header value sent by the HTTP service.

Workaround: None

AMBW-
43566

Summary: Error occurred when Minimum QTP Threads and Maximum QTP
Threads values in the HTTP Connector resource are set as one.

Workaround: If Minimum QTP Threads value is set as one then set the Maximum
QTP Threads value greater than one.

AMBW-
43361

Summary: Performance degradation is observed with Java 11 platform while
using SSL configuration with Mutual Authentication.

Workaround: None

AMBW-
36777

Summary: Error occurred on the Send HTTP Request activity with HTTP Client
shared resource using HTTP1 Apache HttpComponents and connector SR using
HTTP 2.0 with Follow HTTP1 Compliance checked.

Workaround: Use the Jetty client as the client library for implementation under
HTTP Client shared resource.

JAVA Palette

Key Description

AMBW-
13526

Summary: In Java To XML activity, the Output tab is not populated correctly, if
Java class contains nested object references in different classes.

Workaround: None.
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AMBW-
36229

Summary: Unnecessary error logs are displayed in the log file.

Workaround: None

AMBW-
23464

Summary: The Oracle DataDirect driver does not support cursor datatype.

Workaround: Use native drivers instead of DataDirect drivers.

AMBW-
23260

Summary: MySQL Community Edition is not supported for Data Direct drivers

Workaround: Use native drivers instead of DataDirect drivers.

AMBW-
23193

Summary: When using DataDirect drivers with the JDBC shared resource, that is
linked to a JDBC process, the SQL Builder Wizard does not work correctly.

Workaround: Use native drivers.

AMBW-
20130

Summary: The login timeout value is not effective when connecting to a Windows
OS database. The JDBC Query activity fails with the
error,JDBCConnectionNotFoundException at runtime without honoring the Login
Timeout value specified in the JDBC Connection Shared Resource.

Workaround: None

AMBW-
14624

Summary: The Set Explicit Nil check box for Objects and Collections in JDBC
Call Procedure activity is disabled.

Workaround: None

AMBW-
14547

Summary: When you migrate an TIBCO ActiveMatrix BusinessWorks™ 5.x project
containing in-built functions in the JDBC Query activity, an invalid column name
error is thrown in the JDBC Query activity.

Workaround: Use an Alias instead of the in-built functions in the ActiveMatrix
BusinessWorks™ 5.x project.

AMBW-
11667

Summary: Using any in-built function in JDBC Query activity without "Alias" fails
to execute the application and throws an Invalid Column name error at run time.
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Workaround: Use "Alias" to work with any in-built function in JDBC Query
activity.

AMBW-
11624

Summary:TIBCO Business Studio for BusinessWorks stops responding when
opening SQL Builder if the database details on the JDBC shared resource are
changed from PostgreSQL to MySQL after a query has been created using SQL
builder.

Workaround: None

AMBW-
8855

Summary: The localized error messages of JDBC connection are not displayed
correctly in TIBCO Business Studio for BusinessWorks.

Workaround: None

JMS Palette

Key Description

AMBW-
38735

Summary: ActiveMatrix BusinessWorks does not support parsing the Date-Time
elements in the JMS application properties schema.

Workaround: TIBCO recommends not to use such elements in the JMS
application properties schema.

Mail Palette

Key Description

AMBW-
47225

Summary: The OAuth 2.0 Token mail server gets connected back after session
expiry but does not receive/fetch any new email.

Workaround: Stop and rerun the application.

AMBW-
47189

Summary: Intermediate Issue in Receive Mail Activity, the Basic protocol Test
Connection button is not working.
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Workaround: None

XML Palette

Key Description

AMBW-
31813

Summary: Use of pipe(union) ('|') character in XSLT throws the following error at
runtime:

com.tibco.bw.palette.xml.runtime.fault.XMLTransformException: Exception
[org.genxdm.xpath.v20.err.ConcreteErrException] occurred during XSLT
transformation. Exception detail [org.genxdm.xpath.v20.err.ConcreteErrException:
[XPTY0004] Either the expression has a static type that is not appropriate for the
context in which it occurs, or the dynamic type of the value does not match the
required type.]

Workaround: Open the XSLT file and manually convert the pipe (union) ('|')
operator to "or" operator and run the project

AMBW-
14292

Summary: The Parse XML activity displays blank ErrorCode and ErrorMessage for
activity output data validation error.

Workaround: None

REST and JSON Palette

Key Description

AMBW-
28795

Summary: The Parse JSON activity fails to pick up the prefixes defined in the
namespace registry and provides the output with the default namespace prefixes.

Workaround: None
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Policy
This topic lists the Known Issues related to Palettes.

Key Description

AMBW-
34607

Summary: Marketo plugin container edition breaks with the recent JRE upgrade.

Workaround: Please refer Marketo plug-in documentation for more information.

AMBW-
19513

Summary: If a SOAP binding is not configured with Transport, the Add New
Policy icon should be disabled, the Policy field should not be displayed in the
tree view, and a NULL pointer exception is generated if you try to add a policy on
the binding.

Workaround: None
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TIBCO Documentation and Support Services
For information about this product, you can read the documentation, contact TIBCO
Support, and join TIBCO Community.

How to Access TIBCO Documentation

Documentation for TIBCO products is available on the TIBCO Product Documentation
website, mainly in HTML and PDF formats.

The TIBCO Product Documentation website is updated frequently and is more current than
any other documentation included with the product.

Product-Specific Documentation

The following documentation for this product is available on the TIBCO ActiveMatrix
BusinessWorks™ page:

l TIBCO ActiveMatrix BusinessWorks™ Release Notes

l TIBCO ActiveMatrix BusinessWorks™ Installation

l TIBCO ActiveMatrix BusinessWorks™ Application Development

l TIBCO ActiveMatrix BusinessWorks™ Bindings and Palettes Reference

l TIBCO ActiveMatrix BusinessWorks™ Concepts

l TIBCO ActiveMatrix BusinessWorks™ Error Codes

l TIBCO ActiveMatrix BusinessWorks™ Getting Started

l TIBCO ActiveMatrix BusinessWorks™ Migration

l TIBCO ActiveMatrix BusinessWorks™ Performance Benchmarking and Tuning

l TIBCO ActiveMatrix BusinessWorks™ REST Implementation

l TIBCO ActiveMatrix BusinessWorks™ Refactoring Best Practices

l TIBCO ActiveMatrix BusinessWorks™ Samples

https://docs.tibco.com/
https://docs.tibco.com/
https://docs.tibco.com/products/tibco-activematrix-businessworks
https://docs.tibco.com/products/tibco-activematrix-businessworks
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How to Contact TIBCO Support

Get an overview of TIBCO Support. You can contact TIBCO Support in the following ways:

l For accessing the Support Knowledge Base and getting personalized content about
products you are interested in, visit the TIBCO Support website.

l For creating a Support case, you must have a valid maintenance or support contract
with TIBCO. You also need a user name and password to log in to TIBCO Support
website. If you do not have a user name, you can request one by clicking Register on
the website.

How to Join TIBCO Community

TIBCO Community is the official channel for TIBCO customers, partners, and employee
subject matter experts to share and access their collective experience. TIBCO Community
offers access to Q&A forums, product wikis, and best practices. It also offers access to
extensions, adapters, solution accelerators, and tools that extend and enable customers to
gain full value from TIBCO products. In addition, users can submit and vote on feature
requests from within the TIBCO Ideas Portal. For a free registration, go to
TIBCO Community.

http://www.tibco.com/services/support
http://www.tibco.com/services/support
http://www.tibco.com/services/support
https://ideas.tibco.com/
https://community.tibco.com/
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Legal and Third-Party Notices
SOME TIBCO SOFTWARE EMBEDS OR BUNDLES OTHER TIBCO SOFTWARE. USE OF SUCH EMBEDDED
OR BUNDLED TIBCO SOFTWARE IS SOLELY TO ENABLE THE FUNCTIONALITY (OR PROVIDE LIMITED
ADD-ON FUNCTIONALITY) OF THE LICENSED TIBCO SOFTWARE. THE EMBEDDED OR BUNDLED
SOFTWARE IS NOT LICENSED TO BE USED OR ACCESSED BY ANY OTHER TIBCO SOFTWARE OR FOR
ANY OTHER PURPOSE.

USE OF TIBCO SOFTWARE AND THIS DOCUMENT IS SUBJECT TO THE TERMS AND CONDITIONS OF A
LICENSE AGREEMENT FOUND IN EITHER A SEPARATELY EXECUTED SOFTWARE LICENSE AGREEMENT,
OR, IF THERE IS NO SUCH SEPARATE AGREEMENT, THE CLICKWRAP END USER LICENSE AGREEMENT
WHICH IS DISPLAYED DURING DOWNLOAD OR INSTALLATION OF THE SOFTWARE (AND WHICH IS
DUPLICATED IN THE LICENSE FILE) OR IF THERE IS NO SUCH SOFTWARE LICENSE AGREEMENT OR
CLICKWRAP END USER LICENSE AGREEMENT, THE LICENSE(S) LOCATED IN THE “LICENSE” FILE(S) OF
THE SOFTWARE. USE OF THIS DOCUMENT IS SUBJECT TO THOSE TERMS AND CONDITIONS, AND
YOUR USE HEREOF SHALL CONSTITUTE ACCEPTANCE OF AND AN AGREEMENT TO BE BOUND BY THE
SAME.

This document is subject to U.S. and international copyright laws and treaties. No part of this
document may be reproduced in any form without the written authorization of Cloud Software
Group, Inc.

TIBCO, the TIBCO logo, the TIBCO O logo, ActiveMatrix BusinessWorks, ActiveSpaces, Business Studio,
TIBCO Business Studio, TIBCO Designer, TIBCO Enterprise Administrator, Enterprise Message Service,
Rendezvous, and TIBCO Runtime Agent are either registered trademarks or trademarks of Cloud
Software Group, Inc. in the United States and/or other countries.

Java and all Java based trademarks and logos are trademarks or registered trademarks of Oracle
and/or its affiliates.

This document includes fonts that are licensed under the SIL Open Font License, Version 1.1, which is
available at: https://scripts.sil.org/OFL

Copyright (c) Paul D. Hunt, with Reserved Font Name Source Sans Pro and Source Code Pro.

All other product and company names and marks mentioned in this document are the property of
their respective owners and are mentioned for identification purposes only.

This software may be available on multiple operating systems. However, not all operating system
platforms for a specific software version are released at the same time. See the readme file for the
availability of this software version on a specific operating system platform.

https://scripts.sil.org/OFL
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THIS DOCUMENT IS PROVIDED “AS IS” WITHOUT WARRANTY OF ANY KIND, EITHER EXPRESS OR
IMPLIED, INCLUDING, BUT NOT LIMITED TO, THE IMPLIED WARRANTIES OF MERCHANTABILITY,
FITNESS FOR A PARTICULAR PURPOSE, OR NON-INFRINGEMENT.

THIS DOCUMENT COULD INCLUDE TECHNICAL INACCURACIES OR TYPOGRAPHICAL ERRORS. CHANGES
ARE PERIODICALLY ADDED TO THE INFORMATION HEREIN; THESE CHANGES WILL BE INCORPORATED
IN NEW EDITIONS OF THIS DOCUMENT. CLOUD SOFTWARE GROUP, INC. MAY MAKE IMPROVEMENTS
AND/OR CHANGES IN THE PRODUCT(S) AND/OR THE PROGRAM(S) DESCRIBED IN THIS DOCUMENT AT
ANY TIME.

THE CONTENTS OF THIS DOCUMENT MAY BE MODIFIED AND/OR QUALIFIED, DIRECTLY OR
INDIRECTLY, BY OTHER DOCUMENTATION WHICH ACCOMPANIES THIS SOFTWARE, INCLUDING BUT
NOT LIMITED TO ANY RELEASE NOTES AND "READ ME" FILES.

This and other products of Cloud Software Group, Inc. may be covered by registered patents. Please
refer to TIBCO's Virtual Patent Marking document (https://www.tibco.com/patents) for details.

Copyright © 2023. Cloud Software Group, Inc. All Rights Reserved.

https://www.tibco.com/patents
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